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1 Introduction

Grandpa’s Railroad is an integrated hardware and software system designed to
provide computerized control for model trains. It caters to a wide range of model
train enthusiasts, from beginners to seasoned club members. Our primary
objective, which we successfully achieved, was to develop a user-friendly system
requiring no programming expertise and minimal hardware setup. The system
offers highly realistic automation, including signals, gates, flashers, locomotive
sounds, speed control, and more—all at an affordable price.

Grandpa’s Railroad Control Panel offers a sophisticated computerized interface
for model train operations, enabling control of turnouts, sensors, signals, and
even locomotives based on their positions on the layout, when paired with
Grandpa’s Railroad DCC Throttle. The system is centralized, with all data routed to
a single Windows 11 Mini PC, which handles all computational tasks for the
control panel. This centralized design allows for the use of advanced algorithms to
process data seamlessly, without the user needing to be aware of the complexities
involved. For example, IR proximity locators—typically affected by varying lighting
conditions—can be continuously recalibrated, effectively eliminating these issues.
Additionally, in a centralized system, each component can operate independently,
meaning they aren’t restricted to a specific function. This flexibility allows devices
like proximity locators to serve multiple purposes, such as activating crossing
flashers, managing train traffic signals, supporting collision avoidance, and even
enabling animation, all within one integrated system.

1.1 Trading Wires for WIFI

Centralized systems often face challenges due to the extensive wiring needed to
transmit data to a central processing unit and the significant space required for
boards that digitize and manage this data. The abundance of wiring makes
centralized control in modular layouts nearly unfeasible. Grandpa’s Railroad
addresses these issues by digitizing and processing data locally—near its source—
and then transmitting it to and from the centralized system via Wi-Fi. Depending
on the router used, data can be reliably transmitted over several hundred feet,
accommodating even very large layouts. Currently, Grandpa’s Railroad software
supports up to 32 Wi-Fi modules, which come in two types: Digital/Proximity
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modules and RFID/Analog modules. The Digital/Proximity Wi-Fi module can
handle up to 16 digital I/O elements and 16 proximity locators. Since a turnout
requires only one digital I/O connection, this setup allows for up to 512 turnouts
and 512 proximity locators on a single control panel if only this type of module is
used. The RFID/Analog module can manage two RFID readers and two analog
inputs.

1.2 Dedicated Processor and Router for Reliable Operation
Grandpa’s Railroad software comes pre-installed on a Windows 11 Mini PC to
eliminate installation issues. Anyone who has used a Windows PC has likely
encountered a newly installed software package requesting system changes.
These changes can sometimes modify dynamic link libraries or drivers, which may
not be compatible with our software—games, in particular, are known for this.
Rather than troubleshooting installation problems on older computers or handling
potential claims that our software "doesn't work," we provide customers with a
pre-installed, pre-tested system.

This does not mean you cannot install additional reliable software, such as
Microsoft Office, later. The Mini PC we provide is more than capable of handling
such applications. While we do not guarantee a specific brand, we ensure that the
PC includes two 4K display ports. This allows you to use multiple displays for your
layout and provides room for future model train control enhancements without
requiring you to purchase a new Mini PC.

Most homes have a Wi-Fi router, typically used for streaming, gaming, and other
bandwidth-intensive applications. These activities can quickly consume a router’s
capacity. Since small routers are inexpensive, we strongly recommend using a
dedicated router for Grandpa’s Railroad. While you can use your existing home
router, be mindful of potential bandwidth limitations. To simplify setup, we’ve
included a pre-installed software application to program our Wi-Fi modules for
your router.



1.3 Ease of Use

From its inception, Grandpa’s Railroad was designed with simplicity in mind. Our
goal was to create a system that anyone could use, provided they possess basic
skills such as counting, adding, using a screwdriver, handling pliers, and operating
a Windows PC. We are confident we have achieved this goal.

No programming knowledge is required to operate the system. The setup process
is straightforward, utilizing conventional dialog boxes—many of which include
illustrations to guide users through data entry. Additionally, the software features
robust error-checking mechanisms to detect potential issues or missing inputs.

Despite its ease of use, the system does not compromise on flexibility or
sophistication. Behind the scenes, advanced algorithms power its various features,
but users are not required to interact with or understand these complexities.

1.4 Educational Benefits

One of the key goals of Grandpa’s Railroad is to inspire young people’s interest in
science and engineering. We believe that many young individuals are naturally
drawn to both model trains and computers, so we have combined the two.
Scientific and engineering creativity can be just as fulfilling as art or music, and we
aim to encourage that exploration.

To support this, we are developing a video course on electricity designed for
absolute beginners—those with no prior knowledge of the subject. While the
course is not specifically for children, it serves as a resource for parents,
grandparents, group leaders, and mentors who want to help younger learners
grasp the fundamentals. Typically, introductory courses are labeled as "101" (e.g.,
Cooking 101, Sewing 101). However, our course is called Electricity 99 because it
starts at an even more basic level, beginning with the atom and building from
there.

Since hands-on learning is crucial to understanding, we encourage viewers to
replicate the experiments demonstrated in the videos. These videos are available
on our website, GrandpasRR.com, and our YouTube channel, Grandpa’s Railroad.



https://grandpasrr.com/
https://www.youtube.com/channel/UClzT8cCfgk9fdKtBXvBBmcg

Additionally, Grandpa’s Railroad software includes various features that provide
visual insights into its data. For example, users can view plots of data captured by
IR proximity locators (see Section 3.6.4 for details).

We also encourage our users to share the creative animations and unique
implementations they have developed using Grandpa’s Railroad.

1.5 User Manual Outline
Grandpa’s Railroad Control Panel Software operates in three modes:

1. Layout Setup
2. Control Panel Setup
3. Control Panel

The first mode, Layout Setup, involves defining the layout of your model railroad,
including the placement of tracks, turnouts, and other elements.

The second mode, Control Panel Setup, focuses on configuring how the layout
elements interact with the hardware, ensuring proper connections and
functionality.

The third mode, Control Panel, is where you operate the control panel to manage
your model railroad. The first two steps typically need to be completed only once
unless you make modifications or expansions to your layout. Since the control
panel is software-based, expanding your layout is straightforward.

Overview of the Manual

o Chapter 2 covers the initial steps in building a control panel, including
defining the layout size, selecting a layout type, and customizing turnouts if
needed.

o Chapter 3 provides a comprehensive guide to each layout element,
addressing both hardware and software setup, along with practical
examples.
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« Chapter 4 explores software tools that assist in control panel development,
such as axes, grids, connection viewing and printing, problem-checking
features, and customization options.

« Chapter 5 delves into advanced topics, offering insights, best practices, and
detailed instructions for integrating specific features into your layout.

This structured approach ensures a clear and efficient process for setting up and
managing your Grandpa’s Railroad control panel.
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2 Layout Basics

The first step in defining a layout is determining its size and type. Additionally, this
chapter covers the process of defining custom turnouts, which may be necessary
before beginning layout construction, especially if you have hand-built turnouts or
ones not included in our list. If you are using an RFID reader to identify
locomotives, RFID tag data is required. This data enables the transmission of DCC
commands to Grandpa’s Railroad DCC Throttle Software, allowing it to activate
various functions for specific locomotives.

2.1 Defining the Layout Size and Type
When you first start the software, a dialog box will appear, prompting you to
select the basic mode. To begin, choose Layout Setup.

Made Selection Dialog X

Operating Mode
+ Caontral Panel

" Control Setup

" Layout Setup

Continue

Quit

After that, from the main menu at the top of the screen, navigate to Define
Layout and select Define Layout Size and Type.
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i Grandpa's Railroad
File Define Layout Help

Define Layout Size and Type -

Define Layout/Define Layout Size and Type

This will bring up the layout definition dialog box.

Layout Size Dialog x

Dimensions Train Scale

Width (W) 0,000 P Z Scale
Heigth (H) 0.000 inches

HO Scale

oK Cancel

In this dialog, you'll be asked to enter the dimensions of the smallest rectangle
that can completely enclose your entire layout, even if the layout itself is not
rectangular in shape. The dimensions should always be entered in inches. This
step is essential as it helps define the overall space for your layout, ensuring the
software knows the maximum boundaries of your setup.

Before exiting the dialog, be sure to select the appropriate train scale for your
layout. Currently, only N and HO scales are supported. Although Z scale is listed as
an option in the dialog, it is not yet supported in this version of the software, so
be sure to select one of the available options.

Once you've defined the size and type of your layout, you will notice additional
menu options appear. These new options will allow you to further define and add
various elements to your layout, such as track segments, borders, buildings,
buttons, proximity locators, and more. This enables you to continue building your
layout with the specific components that fit your needs.
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2.2 Shifting the Layout

If you want to expand your layout or create additional space on your control panel
to add buttons along the edges, this can be easily done by accessing the "Define
Layout Size and Type" option in the Layout Setup mode. When the dialog appears,
simply increase the height or width to your preferred size. The extra space will be
added to the right and/or bottom of the layout. To add the space to the left or top
of the layout instead, shift the layout by selecting the following option:

¥ Grandpa's Railroad
File View Define Layout Help

Define Layout Size and Type

Shift Layout <4

Define Custom Turnout

Define RFID Tags
Add Track Segrment »
Add Other Component »

Define Layout/Shift Layout

Upon selecting this menu item, the following dialog will appear.

Layout Shift Dialog x

Horizontal Shift

0.000 Inches  (+indicates right shift, - indicates left shift)

Vertical Shift

0.000 Inches  (+indicates down shift, - indicates up shift)

QK Cancel \

You can now enter the desired left or right shift for your layout.
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2.3 Defining Custom Turnout

If you have turnouts from a manufacturer not listed or custom-made ones, you
can add them to the turnout list by using the "Define Custom Turnout" option.
This will appear once the train scale is set.

To add a custom turnout, select:

File View Define Layout Help
Define Layout Size and Type
Shift Layout

Define Custom Turnout _

Define RFID Tags

Add Track Segment »
Add Other Component »
Import Module

Define Layout/Define Custom Turnout

When you select this option, a dialog box will open.

Custom Turnout Dialog

Turnout List for Current Layout Scale

Atlas N Scale Code 55 Right #5
Atlas N Scale Code 55 Left #5
Atlas N Scale Code 55 Right #7
Atlas N Scale Code 55 Left #7
Atlas N Scale Code 55 Right #10
Atlas N Scale Code 55 Left 10

=

Turnout List for Current Layout Scale

Atlas N Scale Code 55 Right #5
Atlas N Scale Code 55 Left #5 |

Atlas N Scale Code 55 Right #7

Atlas N Scale Code 55 Left #7

Atlas N Scale Code 55 Right #10

Atias N Scale Code 55 Left 10 Cancel
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In the bottom corner, you'll see a list of turnouts currently defined for the selected
layout scale. You can either select an existing turnout to modify or create a new
one by choosing "New Turnout" at the bottom of the list.

If you select an existing turnout, the dialog will populate with its parameters and
display an image to visually illustrate these settings.

Custom Turnout Dialog X
e Turnout Main + Turnout Type
| | Exit Length ‘ ¥ Straight Turnout
“ Turnout Length ; x " Curve Turnout
1 : “+ ICP to PF ) \ | ¥ Turnout
| e v,
| : Lt S \ |
: i no o E
| I " " -“g*“\ﬁ“g \ 1 Turnout Length
! :
i : . [
v L 8.541
i 3 TR
| I = 4 I Side Turnout Angle ICP to PF
I : '/l Lo i Le.ft Hand ’—3‘530
. R " + is Right Hand
!_ . T ‘\____I__" Main Exit Length
| | Main Turnout Angle 2,666
f i Is O for Straight Turnout
! Intersection of Center Points {ICP) \ ! Side Exit Length
) 2.714
Point of Frog (PF)
Side Exit Angle
Straight Turnout
Turnout List for Current Layout Scale Turnout Name
NMRA N Scale Right #7 E
NMRA N Beale Left 57 NMRA N Scale Left #10
NMRA N Scale Left #10 |
Test Old Shool Right Save As New ‘ Delete ‘ Cancel ‘

Test Old Shool Left

You can then edit the parameters and either save the changes or save them under
a new name.

If you select "New Turnout," the dialog will update, allowing you to choose the
type of turnout.
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‘Customn Turnout Dialog

—Turnout Type
" Straight Turnout

i Curve Turnout

i ¥ Turnout

Turnout List for Current Layout Scale

Test Old Shool Right

Test Old Shool Left

Right Curve Turnout

Left Curve Turnout

Y Turnout I

Save

Turnout Type ————

~ straight Turnout

" Curve Turnout

¥ Turnout

Cancel |

Once you select a type, the relevant parameters and an image to illustrate them
will appear. For example, a Y-turnout will display the corresponding parameters.

Custom Turncut Dialog

Y

Turnout Body Length -

“ICPtoPF »

Side Turnout Angle

Minus Number

Main Turnout Angle
Paositive Number

Intersection of Center Points (ICP)

A Turngy,
Point of Frog (PF) Exit M:""

enge Note: Main is always the Right Side

Y Turnout

Turnout Type ————
" Straight Turnout

© Curve Turnout

@ ¥ Turnout

Turnout Body Length

IO‘OOO

ICP to PF
I 0.000
Main Exit Length

IU‘UUU

Side Exit Length

IO‘DOO

Main Exit Angle
I 0.000

Side Exit Angle

Turnout List for Current Layout Scale

Test Old Shool Right

Test Old Shoal Left

Right Curve Turnout

Left Curve Turnout

Y Turnout I

Turnout Name

I Mew Turnout

ookt

I0.000

Cancel |
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After entering the necessary data, click "Save" to store the definition under the
chosen Turnout Name. If the data is incorrect, an error message will appear,
detailing what needs to be corrected.

2.4 Defining RFID Tags

RFID Tag data is required if you're using an RFID reader to identify locomotives.
This data enables the sending of DCC commands to Grandpa’s Railroad DCC
Throttle Software, activating various locomotive functions. To input this data,
select the following menu option:

i Grandpa's Railroad
File View Definelayout Help

Define Layout Size and Type
Shift Layout

Define Custom Turnout

Define RFID Tags _

Add Track Segment >
Add Other Component »

Define Layout/Define RFID Tags

Upon selecting this menu item, a dialog box will appear.
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Train Tag Dizlog X

RFID Tags
Locomotive Identification Defining Colors
Add Tag | Edit Tag | Delete |

Train Color

= Box Calor
DCC Address Border Color

Text Color
Train Label

dth

04 Cancel ‘

Once you have installed an RFID Tag on a locomotive the first thing is to determine
the identifier or Tag number. This is done by running the locomotive over an RFID
reader that you have installed on your layout and read the identifier from the
display. (If you have not entered tag data for the tag yet, the identifier will be

displayed.)

After you obtain the tag number you can enter it in the tag box above along with
the locomotive DCC address and the label you wish to be displayed as the train
passes over the reader. Also, by pressing the buttons in the Defining Colors group
a dialog will appear allowing you to choose a color for each category. The
categories are:

e Train Color Color the proximity locator will change when the train
activates it.

e Box Color Color the RFID reader display background will change when
the tag is read.

19



e Border Color Color the RFID reader display border will change when the
tag is read.

e Text Color Color the RFID reader display text will change when the tag
is read.

After adding all the data, you can left click with your mouse on the Add Tag button
to add the data to the list.

You can edit or delete a code by highlighting it in the list box (clicking it with the
left mouse button) and then pressing the Edit Tag or Delete button.

An example of the dialog with tag data is shown below:

Train Tag Dizlog *

RFID Tags

Address = 3106 : Tag = 445257428 : Label = UP 3106
Address = 3106 : Tag = 445267204 : Label = UP 3106
Address = 3705 : Tag = 445283332 : Label = UP 3705

Locomotive Identification Defining Colors

Add Ta | Edit Ta | Delete |
< g Train Color
Tag 445283330 Box Color

DCC Address 3705 Border Color

Train Label UP 3705 Text Color -

el

QK ‘ Cancel ‘

If you look closely, you’ll notice that more than one tag can be defined with the
same locomotive address. It’s possible to use multiple tags on a single locomotive.
Our tags and readers have been tested at 100 scale miles per hour with over a
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95% success rate in tag reading. (Success depends on tag placement, reader
installation, distance between the tag and reader, and the time the tag spends
crossing the reader.) If you have a high-speed train running at scale speed, adding
a second tag can increase the likelihood of identification. The second tag should
be placed at the opposite end of the locomotive, not next to the first.
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3 Adding an Element to Your Layout

Each element in a layout may have unique hardware requirements and functions
to be executed in each software mode. The process of adding an element to your
layout will be thoroughly explained, covering the following areas (if applicable):

1.
2.
3

4.
5.
6.

Hardware Requirements

Adding to the Layout

. Control Panel Setup

Control Panel Operation
Special Considerations

Practical Example

The table below outlines each element and includes quick links to their respective
sections.

Element Section
Adding Straight Track 3.1
Adding Curved Track 3.2
Adding Turnout 3.3
Adding Border Line 3.4
Adding Button 3.5
Adding Proximity Locator 3.6
Adding Gate, Signal, or Animation 3.7
Adding Collision Avoidance 3.8
Adding DCC Event or Sequence 3.9
Adding Digital Input for Control Panel 3.10
Adding Digital Input for DCC Panel 3.11
Adding Analog (Speed) Input for DCC Panel 3.12
Adding RFID Reader 3.13
Adding WIFI Module 3.14
Adding Legend 3.15
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3.1 Adding Straight Track

A straight track section isn't defined by a specific length; rather, it can refer to a
continuous straight section made up of multiple individual pieces.

3.1.1 Hardware Required

Hardware is only necessary if you're configuring this section to control the power
for the entire block. A block encompasses all track elements that are electrically
connected, meaning all elements between track insulators. Defining blocks within
a layout is crucial for isolating segments, preventing collisions, and in non-DCC
layouts, allowing locomotives to park on sidings. A 2-state Track Control card can
either power off a block or connect it to a single power source, such as a Cab
(Throttle Power Pack) or another track section. In DCC systems, there’s only one
power source, so this card will simply toggle the power on or off.

The 2-state Track Control card functions similarly to a solid-state double-pole,
single-throw switch. The wiring setup is as follows:

Grandpa’s Railroad
Ll Ll
0néh
.

€3 i4
"

ey 44

Note: Input power could be a DC Controller, power
currently being supplied to another block, or in the case
of DCC a DCC power supply.

A simplified diagram for this configuration is:

+
Input J

Power o

Note: Input power could be a DC Controller, power
currently being supplied to another block, or in the case
of DCC a DCC power supply.
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3.1.2 Adding a Straight Track Section to Your Layout
From the main menu select

i Grandpa's Railroad
File View Definelayout Help
Define Layout Size and Type

Shift Layout

Define Customn Turnout

Define RFID Tags

Add Track Segment » Straight —
Add Other Component » Curve

Turnout

Define Layout/Add Track Segment/Straight

After selecting this menu item, the following dialog box will appear.

Straight Track Edit Dialog X
Block Number 0 Block Color
Start Point Position Angle/Length
Horizontal in inches Input Angle Deg
0,000 0,000
- Angle
Vertical in inches Length in inches %
0.000 0.000 ‘I
- = e Rt T 0 Angle
Input Angle !
Start Point WA” ¥
+ Angle
End Point ——
Line Definition
" End Points *+ Angle/Length
CK Cancel ‘

In this form, you can enter the starting point, angle, and length for the straight
track segment. If you prefer to define the two endpoints for the line, select the
Line Definition/End Points" option, which will change the dialog as follows:
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Straight Track Edit Dialog X

Block Number 0 Blodk Color
Start Point Position Point 2 Position
Horizontal in inches Horizontal in inches
0.000 0,000
e - Angle
Vertical in inches Vertical in inches %
0.000 0.000 ‘I
o g = mm ) e mm o —- T 0 Angle
Input Angle !
Start Point WA” ¥
+ Angle
End Point ——
Line Definition
{* End Points ™ Angle/Length
OK Cancel |

In addition to defining the segment, you must also input the Block Number, which
must be a value between 1 and 100. A Block Number represents all track elements
that are electrically connected, i.e., all elements located between track insulators.
Defining blocks in a layout is crucial for isolating segments to avoid collisions, and
in non-DCC layouts, it allows for parking locomotives on sidings.

After entering the Block Number, if it has already been used for another segment,
its associated color will be displayed. If it has not been previously used, you will be
prompted to define a color by clicking the "Block Color" button, which will bring
up the following dialog:
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Color >
|
N
LN
o n
o E
__ N
- . Hue: 'I Red: D
== .- -
Define Cuzstomn Colars > ColoriSelid |, - Iu_ Ellue:lﬂ—
ok | cancel | Add to Custom Colors |

If the color has been previously defined and you select the Block Color button, the
color you select from the dialog that appears will be applied to all track segments
with that Block Number.

Once you select "OK" from the Straight Track Editing dialog, and if all required
data has been entered correctly, the track segment will be added to the layout. If
there are any errors in the data, a detailed error message will appear, explaining
what needs to be corrected.

To edit an existing track segment, simply left-click on the track segment's Edit
Location. This will reopen the dialog (See Show Edit Locations).

3.1.3 Setting Up a Straight Track Section as a Block Control

When you set up a Block Control on a track segment, the image (a single round
button) will appear as shown below.
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As the name implies, a 2-State Block Control allows you to either cut power to the
block or connect to one power source. For DCC operation this would be DCC
power and for DC operation this could be either a throttle cab or another track
block.

To set up a straight track section for your layout as a Block Control you must be in
the Control Setup mode. Using the Left Mouse Button, click the Control Box (See
Show Control Boxes) for the section on the layout and the following dialog will
appear.

Track Contral Dialog >

Block Mumber 1

Control Properties

[ This Control is Hidable

Control Color On

Cab #

Pin To Use

WIFI Module #
Pin #

Delete Active Cannection

QK Cancel
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Using this dialog, the Block Control can be customized.

This Control is Hidable: When operating in control panel mode, several options
are available to simplify the display. One of these options allows active Block
Control Points to be hidden. However, they can only be hidden if the control has
been designated as hidable by checking this box.

Control Color On: This group allows you to specify the color of the track control
when it is ON. The OFF color is always dark gray. The color is determined by
specifying the Cab # you are connected to (see Section 4.6).

« For DC operation: If you have multiple Power Packs, you can assign each a
different color. This helps easily identify which Power Pack is controlling the
track.

» For DCC operation: Since there is only one power source, you can choose a
Cab # and assign it a color of your preference.

Pin to Use: You must enter the Digital/Proximity WIFI Module number that the
Throttle Control card is connected to. This number corresponds to the actual
number programmed into the WIFI Module.

Note: You must use the WIFI Module Programmer software to

program that number and your router name and password into
each module.

Use the WIFI Module Programmer software to assign this number. The Pin # is
calculated by adding the number of the connector on the WIFI Module (where the
ribbon cable is connected) and the Input Pin number on the card used.

Delete Active Connection: This option removes the track control from the current
block.
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3.1.4 Control Panel Operation of a Block Control

On the control panel, the circle on the Block Control indicates the power source to
which the block is connected.

For DCC operation, there is only one power source. In this case, the Block Control
simply shows whether the block is on or off.

For DC operation, the circles on the Block Control indicate the power source—
either a Cab or a connection to another block’s power source.

To illustrate, consider the layout shown below.

In this example, both the OFF and ON conditions are displayed. Note that the
titles do not appear on the layout.

3.1.5 Practical Example 2 State Block Control

A simple example of a 2-state Active Block Control is illustrated below. In this
example, we will use a multimeter to demonstrate the power source connection.
High resistance indicates that the input is not connected to the output, while low
resistance shows that the power source is connected, and power will be available
at the output connector.

Step 1: Connect a 2-State Track Control Card to the WIFI module. In the photo
below, the card is connected to the +13 connection, and the multimeter is
connected to the +1 connection on the card.



o+ Digital I/O

Controller

Grandpa’s Railroad

Step 2: Launch the Grandpa’s Railroad Application, select the Layout Setup mode,
and create a 30-inch by 30-inch layout in any scale.

Step 3: Add a Digital/Proximity WIFI Module to your layout as described in the
section "Adding a WIFI Module." The module number should be the one assigned
to the module you are using. If you're unsure of the module number, use the WIFI
Module Programmer software to determine it.

Step 4: Add a straight track section at location x =0, y = 15, length = 30, and angle
=0.

Step 5: From the File menu, select:
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i Grandpa's Railroad
File View Definelayout Help

Open Layout
Save Layout

Save Layout As
Program Mode * Control Panel
Exit Control Panel Setup _

Layout Setup

File/Program Mode/Control Panel Setup
This will switch to the Control Panel Setup mode.

Step 6: From the View Menu item select:

¥ Grandpa's Railroad
File View Help

Show Control Boxes _

Show Proximity Locator Connection Metwork

WView or Print Functions ;2

Loom ;2

View/Show Control Boxes
This will display a circle at the center of the straight track segment.

Step 7: Using the left mouse button, click the circle on the straight track segment,
and the following dialog will appear.
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Track Control Dialog x

Block Number 1

Control Properties

[ This Control is Hidable

Control Color Qn

Cab #

Fin To Use

WIFI Module # |
Pin # |

Delete Active Connection

Ok Cancel

Set this as an Active Control Point and enter the Digital/Proximity WIFI Module #
and Pin #. Since we used the +13 connector on the Digital/Proximity WIFI module
and the +1 connection on the card, the pin # will be 14 in this example. The dialog
box should now look as follows:

32



Track Contral Dialog *

Block Mumber 1

Control Properties
| This Control is Hidable

Contral Color On

Cab# |1

Pin To Use

WIFI Module £ |1
Pin % 14

Delete Active Connection

K Cancel

Press OK, and your layout should appear as shown.

M 1

Step 8: Ensure that the Digital/Proximity WIFI Module is powered on. From the
File menu, select:
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i Grandpa's Railroad
File View Definelayout Help

Open Layout
Save Layout

Save Layout As
Program Mode » Control Panel _
Exit Control Panel Setup

Layout Setup

File/Program Mode/Control Panel
This will switch to the Control Panel mode.

Step 9: The Digital/Proximity WIFI Module should now connect to the network
and change to the connected color. The Control Point should indicate the OFF

-

condition, and the multimeter should read high resistance. Pressing the gray dot
will connect the input throttle connection to the output. The layout should now
look like this:

&

The multimeter should show very low resistance, and a red LED will light next to
the +1 connection on the card. This indicates that the throttle is now connected to
the output.



Low Resistance

*t funxosg *6 .

WIFI '

Controller

)

13+
I
il

Ofl leyiByg *§

o4+ Digital /0

+l

Note: When ON, the Throttle Input to Throttle Output + to + and —to —
connections will show low resistance, but the —to + and + to — terminals will
always show high resistance.

3.2 Adding Curved Track

A curved track section is not limited to a specific length of track; instead, it can
encompass an entire curved segment composed of multiple individual pieces. The
only requirement is that all sections of the curve share the same radius.
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3.2.1 Hardware Required

Hardware is only necessary if you intend to control power for the entire block
using this section. If so, refer to 3.1.1 Adding Hardware for Straight Track, as the
process is identical.

3.2.2 Adding a Curved Track Section to Your Layout
From the main menu, select:

i Grandpa's Railroad
File View Definelayout Help

Define Layout Size and Type
Shift Layout
Define Custormn Turnout

Define RFID Tags

Add Track Segment » Straight

Add Other Component » Curve _

Turnout

Define Layout/Add Track Segment/Curve

Upon selecting this menu item, the following dialog will appear.

Curve Track Edit Dialog X

Block Number 0 Block Color

Turn Type ‘

Turn Type
Right Turn
Left Turn

Left Turn

Right Turn

Cancel
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Once you specify whether the turn is to the right or left, the dialog will update

accordingly for a right turn.

Curve Track Edit Dialog

Block Number 0

Turn Type

Block Color

Turn Type Mot Defined
Left Turn

Right Turn

.\
Start Point ———

Start Point Position Properties \ -
— ¥,
Horizontal in inches Radius in inches 'fWEEp An\gle
0.000 0.000 e -
Angle
Vertical in inches
Sweep Angle deg Input Angle X
0.000 v '
0.000 - + - DAngle
Input Angle Deg ‘{
0.000 + Angle

OK Cancel ‘

This allows you to define the turn based on the following parameters:
« Start point: Horizontal and vertical position
« Input angle: Angle at the start point
« Radius: Radius of the turn
» Swept angle: Total angle covered by the turn

These parameters are visually represented in the accompanying diagram within
the dialog.

Additionally, you must enter a Block Number, which can range from 1 to 100. A
Block Number represents all track elements that are electrically connected—i.e.,
all segments between track insulators. Defining Blocks in a layout is essential for
collision avoidance and, in non-DCC layouts, for parking locomotives on sidings.

If the block number has been used previously, the selected color for that Block
Number will be displayed. If it is a new Block Number, you must assign a color
using the Block Color button, which will open the corresponding color selection
dialog.
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Color >
Basic colors:
_IEel el B N
HMTETFHEHNEN
EEEEENEEN
EFNFEEEEEN
EEEEEEEN
1 a N B Nl Bm
Custom colors:
4
======= Hue:lﬁ Hed:lﬂ—
Sat:lﬂ_ Green:lﬂ_
Define Cugtomn Colars = | ColoriSalid Lum;lu_ Ellue:lﬂ—
ok | cancel | Add to Custom Colors |

If a Block Color has already been defined and you select the Block Color button
again, the newly selected color will be applied to all track segments with that
Block Number.

Once you select OK in the Curved Track Editing dialog and all required data has
been entered correctly, the track segment will be placed on the layout. If any data
is incorrect, a detailed error message will indicate the issue.

To edit a track segment, left-click on the track segment's Edit Location, and the
dialog will reappear. (See Show Edit Locations.)

3.2.3 Setting Up a Curved Track Section as a Block Control

Setting up a curved section as a block control follows the same process as a straight
track section. Refer to 3.1.3 Setting Up a Straight Track Section as a Block Control
for details.
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3.2.4 Control Panel Operation of a Block Control

The control panel operation for a curved section is identical to that of a straight
section. Refer to 3.1.4 Control Panel Operation of a Block Control for more
information.

3.2.5 Practical Example
Refer to the examples provided for straight track sections.

3.3 Adding A Turnout

A turnout can be added to the layout from a predefined list. You can also expand
this list using the Define Custom Turnout feature. Available options include right
or left, straight or curved turnouts, as well as Y turnouts.

3.3.1 Hardware Required

There are three types of cards used to connect servo-type turnout machines:
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The Turnout & 1/0 Board has two screw connections for turnout machines.

[l 1)

it A%

The Turnout Control Board has four screw connections for turnout
machines.

Turnout Control Board

B |
Eﬂj 19190180

b/ e

Railroad
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e A similar board to the above uses RJ11 connectors.

Turnout Control Board

N R E [5‘91

One advantage of using Grandpa’s Railroad Control Panel software is that turnouts
are wired consistently, regardless of the turnout machine or connector mounting.
This is because the switch machine direction can be adjusted in the setup dialog

box.

3.3.1.1 Connection to a Tortoise Switch Machine

The Tortoise Switch Machine has two versions, old and new, which differ primarily

in their connectors.
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Old Design New Design

ow

ﬁ aak “6\;7 He¥

The new boards feature an industry-standard edge connector, whereas the old
boards have undersized connectors and should not be used with our optional
edge connector. Instead, they should be connected by soldering.

At Grandpa’s Railroad, we use 26 AWG telephone cable (solid or stranded) for
wiring turnouts. This cable is advantageous because of its color-coded wires and
easy availability.
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The Tortoise Switch Machine wires should always be connected as follows:

Tortoise Turnout Machine Connector

O 006000

Turnout Control Board Connector

00 60

While soldering to the switch machine connector is fine, you could also use this
optional Grandpa’s Railroad connector that slips over the switch machine
connector.

v senl mepl um e e
1 " s W gy WY g

¥ e et e

43



The final wiring setup should resemble the image below:

Turnout Card Switch Machine

A second method of wiring a turnout involves using the Turnout Control Board
with RJ11 connectors. This method simplifies connections, allowing for premade
cables of various lengths—useful when working under a layout. However, this
method requires additional tools for making cables, such as a crimp tool as shown
below:

viring | RIT1- o
miac @
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To do this you must use a Grandpa’s Railroad RJ11 connector.

T g o g 0 g B
P T T T

If you properly make a RJ11 telephone cable, the connections are as follows:

Turnout Card Switch Machine

These connections are simple, clean, and easy to install or change. Also note that
the unused connections on the switch machine are still available through a screw
connector for turnout frog wiring or signals.
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3.3.2 Adding a Turnout to your Layout
From the main menu select

i Grandpa's Railroad

File Wiew DefineLayout Help
Define Layout Size and Type
Shift Layout
Define Custom Turnout

Define RFID Tags

Add Track Segment » Straight
Add Other Component ] Curve

Turnout _

Define Layout/Add Track Segment/Turnout
Upon selecting this option, a dialog box will appear.

Turnout Edit Dialog

Turnout Number |0 Block Number |0 Block Color

Point 1 Position

Horizontal in inches

0.000

Vertical in inches

0.000

Qutput Angle Deg

Turnout Type

Turnout Type Left Hand Straight Turnout Curve Turnout
MNMRA HO Scale Right #4
NMRA HO Scale Left #4 - -
MMRA HO Scale Rioht #6 e — ___—-—?-—-; —

oK Cancel | — e e

Right Hand Straight Turnout Y Turnout

From the Turnout Type list, select the type of turnout you want to add. If the
turnout you want is currently not in the list, you can exit the dialog using the
cancel button and then define a custom turnout and add it to the list. (see
Defining a Custom Turnout).
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After selecting a turnout Type the image in the dialog will change depending on

the type as follows:

Right Hand Straight Turnout

CPaint 3
- - Anl
T e
N )
- o _"‘T"_‘_ 0 Angle
— CPaint 3
_/ Left Hand Straight Turnout +Angle

Y Turnout

|
(W

< poi

> <

7, - Output Angle

.

1™
i

+ Output Angle
o

These images visually define the parameters that must be entered in the dialog,
including the Point 1 position and the Output Angle. Additionally, you must enter
the Block Number, a value between 1 and 100. A Block Number represents all
track elements that are electrically connected, i.e., all elements situated between
track insulators. Defining Blocks in a layout is crucial for isolating segments to
prevent collisions and, in non-DCC layouts, to park locomotives on sidings.

After inputting the Block Number, if it has been previously assigned to another
segment, the selected color for that Block Number will be displayed. If it hasn't
been used before, you'll need to define a color using the Block Color button,
which will prompt the following dialog to appear.
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Color s
Basic colors:
RN N BN
FEEENENEN
s 8 0 0 B B
FEEEEEnN
EEEEEEN
1L 8 B Il Bl
m colors:
EEEEEEN <
Hue:lﬁ Hed:lﬂ—
snnnnnn 2 20

Crefine Custam Colars =3 | ColoriSalid |, . ID Blue: ID

QK I Cancel | Add to Custom Colors |

If the color has been previously defined and you select the Block Color button, the
color you choose from the ensuing dialog will be applied to all track segments
with that Block Number. Once you select OK in the Turnout Edit dialog and have
entered all required data, the turnout segment will be placed on the layout. If the
data is incorrect, a detailed error message will explain the issue.

To edit a turnout, left-click on the turnout element's Edit Location, and this dialog
will reappear. (See Show Edit Locations)

3.3.3 Control Panel Setup for a Turnout

To set up a turnout, you must be in Control Setup mode. Using the left mouse
button, click the Control Box (see Show Control Boxes) near the center of the
turnout, and the following dialog will appear:
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Turncut Control Dialog X

Turnout Control

[ Add Turnout Togale Control

oK Cancel

If you check the box "Add Turnout Toggle Control," additional setup options will
be displayed.
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Turnout Control Dialog >

—Turnout Control
¥ Add Turnout Toggle Control

WIFI Module # |1 Pin # |u

[ add Turnout Toagle Feedbark

[T change turnout response direction

[~ Pair With Second Turnout

[T chedkTurnout Occupied

You must enter the Digital/Proximity WIFI Module number to which the Turnout
Control card is connected. This number corresponds to the one programmed into
the WIFI Module using the WIFI Module Programmer software.




The Pin number is calculated by adding the connector number on the
Digital/Proximity WIFI Module where the ribbon cable is connected to the Input
Pin number on the card used.

"Add Turnout Toggle Feedback" can be enabled if there's a return signal from the
turnout connection indicating the actual turnout position. This feature,
implemented with the Tortoise switch machine connection shown earlier, will
cause an indicator on the display to change when the turnout reaches the desired
position. This will be described in the control panel mode.

"Change Turnout Response Direction" allows you to connect the switch machine
motor and connector in any orientation. The image below shows a switch machine
mounted on a clear surface below a turnout. Red and black tape has been placed

on top of the turnout. Note that when the turnout machine is oriented toward the
red tape, the turnout changes from straight to siding, depending on the mounting.
Similarly, changing the orientation of the connector on the switch machine, as
shown below, will alter the motor's direction.
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By checking the "Change Turnout Response Direction" box, the switch machine's
output direction will change. The easiest way to determine the correct setting for
this box is to complete all hardware and software setup and then test it. If the
indicator on the control panel doesn't match the turnout direction, checking this
box will correct it. Therefore, you don't need to worry about orientation when
mounting your switch machines.

In some cases, two turnouts on a layout should always operate together. For
example:

It would be illogical to allow the following configuration:
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To enable the turnouts to operate together, you can pair them. By checking the
"Pair with Second Turnout" box, the dialog will change, allowing you to enter the
number of the turnout you wish to pair with.

v Pair With Second Turnout

Other Turnouts # ]

Note: The second turnout must also have the pairing option activated with the
appropriate turnout number.

Selecting 'Check Turnout Occupied' will trigger a warning if a train is detected
over the turnout when you attempt to toggle it. By checking this box, the dialog

Iv¥ ChedkTurnout Occupied  Turnout Entry
Proximity %

Turnout Exit
Proximity #s

1]

will update to allow you to enter the proximity numbers for the locators at the
entry (1) and the two exit points (2 and 3) of the turnout.

(] o
(=)

For this feature to work effectively, the proximity locators should be placed near
the turnout.

3.3.4 Control Panel Operation for a Turnout

To change the direction of a turnout in control panel mode, place the mouse
cursor over the circle indicating the desired turnout direction and press the left
mouse button. If you're not using Turnout Toggle Feedback, the circle will be
black and white. Clicking the black circle will toggle its colors, as well as the active
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turnout direction's color. These changes occur immediately. When using Turnout
Toggle Feedback, the colors will be green for the current direction and red for the
other direction. Clicking the red circle will immediately change the active track
direction's color. However, the red and green circles won't change colors until
feedback from the turnout connection confirms the turnout has changed
direction. This positive feedback ensures the turnout direction corresponds to the
actual direction.

If the 'Check Turnout Occupied' feature is enabled and a train is detected over the
turnout or its paired partner (indicated by the entry and at least one exit

proximity locator being ON), a warning message will appear for 5 seconds, and the
turnout will not toggle.

Warning >

':o:' Turnout Occupied! Clear turnout befare toggling turnout.

3.3.5 Practical Example

A simple example of adding a turnout is illustrated below. In this example, we'll

demonstrate how toggling the turnout changes the direction of the Tortoise servo
motor.

Step 1: Connect a Turnout Control and I/O Card to the WIFI module. In the photo
below, the card is connected to the +13 connection, and the turnout is connected
to the +1 connection on the card. Additionally, 12 volts DC should be connected to
the Turnout PWR connector of the card. Ensure the polarity of the 12V is correct.
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Step 2: Launch the Grandpa’s Railroad Application, select Layout Setup mode,

and create a 20-inch by 20-inch layout in HO scale. (Note: A layout doesn't need to
be complete. In this example, we're only adding a turnout.)

Step 3: Add a Digital/Proximity WIFI module to the layout at 2 inches horizontal
and 5 inches vertical, with the desired Connected and Not Connected colors.

55



WIFI Module Dialog X

—WIFI Module Number

1

—Object Location Center Point ——

Harizontal in inches

Colors

IZ-UUU WIFI Mot Connecbedl _
Wertical in inches WIFI Connected |

I 5.000
Ok Cancel |

Step 4: Add a turnout to the layout. Place an NMRA HO Scale Right #8 at 5 inches
horizontal and vertical with a zero-output angle.

Turneout Edit Dialog *

Turnout Mumber I 1 Block Mumber I i Block Colar | _

—Point 1 Position

Horizontal in inches

I 5.000

Vertical in inches

I 5.000

Qutput Angle Deg
| 0.000
Turnout Type
Turnout Type  [yMRA HO Scale Right 6 . s
NMRA HO Seole LeFt %5 Right Hand Straight Turnout - Aagle
NMRA HO Scale Left #3
—i—er—i—e— -k DAngle
oK | Cancel | +Angle




Step 5: From the File Menu item select:

¥ Grandpa's Railroad
File View Define Layout Help

Open Layout
Save Layout

Save Layout As
Program Mode » Control Panel
Exit Control Panel Setup 4=

Layout Setup

File/Program Mode/Control Panel Setup

This will switch to the Control Panel Setup mode.

Step 6: Left click on the turnout element’s Control Box and the following dialog
will appear. (See Show Control Boxes)

Turnout Control Dialog >

Turnout Control

Iv Add Turnout Toggle Control

WIFI Module # 1 Pin # 14

v Add Turnout Toggle Feedback

| Change turnout response direction

[ Pair With Second Turnout

OK Cancel
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Enter the Digital/Proximity WIFI module number and Pin number. Select Turnout
Toggle Feedback. At this point, your layout should look as follows:

M 1

Step 7: Switch to the Control Panel mode. As you toggle the turnout by clicking on
the red circle with the left mouse button, the motor should move from one side to
the other.

If there's an issue, first verify the wiring is correct. Then, ensure the wires are
properly fitted and secured into the connectors.

3.4 Adding Border Line

A borderline is a visible boundary in your layout that you want to display, such as
the outline of a table.

To add a borderline, select the appropriate option from the main menu

Define Layout/Add Other Component/Add Border Line

i Grandpa's Railroad
File View Definelayout Help

Define Layout Size and Type
Shift Layout
Define Custorn Turnout
Define RFID Tags
Add Track Segment ¥
Add Other Component > Add Border Line _
Add Button
Add Proximity Locator
Add Proximity Locator Activated Object >
Add External Input Object >

Add RFID Detector
Add WIFI Module
Add Legend
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Upon selecting this menu item, the following dialog will appear.

Layout Frame Dialog *
Point 1 Position Point 2 Position
Horizontal in inches Horizontal in inches
0,000 0.000
Vertical in inches Vertical in inches
0,000 0,000
[ Hidable
Ok Cancel

This dialog allows you to enter the two endpoints of a border line. You can also
make the line hidable in Control Panel mode, which is useful for defining internal
or side borders of a physical module and later hiding them once the final layout is
complete.

After selecting OK, if all required data has been entered correctly, the border line
will be placed on the layout. Otherwise, a detailed error message will appear,
explaining any issues.

To edit a border element, left-click on the border element's Edit Location, and this
dialog will reappear. (See Show Edit Locations for more details.)

3.5 Adding Button

A button is a switch used to turn a digital pin on or off, allowing it to control
anything connected to that pin.

3.5.1 Hardware Required
The most basic use of a button is to control a light or another external electrical
device. To achieve this, you need at least one Output Pin on an Input/Output Card
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or a Turnout Control & 1/0 Board. The output pins on these boards function as
switches for AC or DC current.

Note: Refer to the card specifications for voltage and amperage limits.

A simple schematic illustrating how to connect a light to the Output Pin is shown
below:

@

—

|

synduj
HE BB

Outputs

—IlF—

Input / Output Card

To learn more about electricity, voltage, and current, watch the educational
tutorial "Electricity 99."

3.5.2 Adding a Button to your Layout
To add a button to your layout, you must be in Layout Setup mode. From the main
menu, select:

B Grandpa's Railroad

File View Define Layout Help
Define Layout Size and Type
Shift Layout
Define Custom Turnout
Define RFID Tags

Add Track Segment »

Add Other Component » Add Border Line
Add Button _
Add Proximity Locator
Add Proximity Locator Activated Object »
Add External Input Object »
Add RFID Reader
Add WIFI Module
Add Legend
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Define Layout/Add Other Component/Add Button

Upon selecting this menu item, the following dialog will appear, allowing you to

Button Dialog X
Start Point Position Size Text Lines
Horizontal in inches Width in inches Looles |
[oo0 oo Middle Line |
Vertical in inches Height in inches
0,000 0,000
Bottom Line * Mone " onfoff O Custom
{* Horizontal (" Vertical Right " Vertical Left
Button Type Colars
" Latchi
" Momentary
Text Top Line Off Text Top Line On
Inverted Button
Upis ON Text Other Lnes Off Text Other Lines On
Down is QFF
[ Invert0/1 Qutput [ Indude Border

oK Cancel ‘

customize each button by adjusting its size, color, text, and other properties. You
must enter the following parameters.

« Start Point Position: Defines the location of the upper-left corner of the
button. If the button is associated with a specific item on your layout (e.g., a
building), it is beneficial to place it near that item.

« Size: Determines the dimensions of the button. If linked to an item, it is
recommended to match the button's size to that of the item.

» Button Type: Specifies whether the button is Latched or Momentary:

o A Latched button turns On with the first left mouse click and Off with
the second.

o A Momentary button remains On only while the left mouse button is
held down.
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« Invert I/0 Output: Reverses the button's state. A momentary button will
normally be On and turn Off while the left mouse button is held down.

» Text Lines: Allows you to add up to three lines of text to the button.

TextLines

Tap Line | Line 1

Middle Line |

Bottom Line * MNone " onfoff {° Custom

* Horizontal " Vertical Right ™ Vertical Left

Text Lines

Top Line |LinE 1

Middle Line |Line 2|

Bottom Line * Mone " onfoff © Custom

{* Horizontal " Vertical Right " vertical Left
TextLines
Top Line |Line 1

Middle Line |Line 2

Bottom Line " Mone + onfoff © Custom

{* Horizontal " Vertical Right " Vertical Left

Line 1

Selecting Bottom Line On/Off will display Off when the button is off and On when

itis on.
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Options like Horizontal, Vertical Right, or Vertical Left adjust the text orientation
accordingly.

TextLines

Top Line | Line 1

Middle Line | Line 2

Bottom Line | Line 3]

Bottom Line " Mone " OnjOff ™ Custom
{* Harizontal " vertical Right " Vertical Left
TextLines

Top Line |LinE 1

Middle Line | Line 2

Bottom Line | Line 3

Bottom Line " Mone (" onfoff * Custom
" Horizontal {* Vertical Right " vertical Left
TextLines

Top Line | Line 1

Middle Line | Line 2

Bottom Line | Line 3

Bottom Line " Mone " onjoff & Custom

" Horizontal " Vertical Right {* Vertical Left
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o Colors: Enables customization of the button’s On and Off colors, including
text color.

—Colors

owncr | [ oo | [

Text Top Line Off | Text Top Line On | _
Text Other Lnes Off | Text Other Lines On | _

[ Indude Border

o Include Border: Allows you to select a border color for the button.

—Colors

ot | [ oo | [

Text Top Line Off | Text Top Line On | _
Text Other Lnes Off | Text Other Lines On | _

¥ Indude Border Border I _
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Additionally, a button can function as a non-active layout element or a line of
text by not associating it with an output pin in Control Panel Setup mode. For a
text-only button, set its color to white.

Text Line 1

3.5.3 Setting Up a Button for your Control Panel
To set up a button for your layout, you must be in Control Setup mode. Using the

left mouse button, click the button image on the layout, and the following dialog
will appear.

Button Pin Connection >

Button Connection

Button Shared LUse Characteristics
Mumber of Pins 1

v Activate Pin even if other pin
WIFI Module Fin = users indicate off

Activate Pin only if a shared
user indicates ON

QK Cancel
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Next, you must select the number of output pins that this button will activate.
Selecting zero is a special case where the button is used as a line of text. You can
activate up to 8 pins with one button. If a non-zero value is selected, the dialog
will update to allow you to enter the output pin to be controlled. For example,
selecting "1" will result in the following change.

Button Pin Connection >

—Button Connection

0 —Button Shared Use Characteristics ——
Mumber of Fins

I Activate Pin even if other pin
WIFI Module Fin £ users indicate off

1 I 0 e Activate Pin only if a shared
user indicates OM

K Cancel

For each output pin that is activated, you need to enter the Digital/Proximity Wi-
Fi module number that the 1/O card is connected to. This number is the actual
number programmed into the Wi-Fi module.
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Use the WIFI Module Programmer software to assign that number.

The pin number is calculated by adding the connector number on the
Digital/Proximity Wi-Fi module (where the ribbon cable is connected) to the
output connector number on the card used.

Turnout Control & 1/0 Board

¥ e¥ o

oy F
Q:’ [ - ?h

-y
‘wm

For example, using the image above, we calculate the pin number by adding 9
from the Digital/Proximity Wi-Fi module and 3 from the board, for a total of 12.
Therefore, you would enter 12 for the pin number.

The final setting to specify is whether the button is shared. Sharing means the
button can be paired with a second button, an external input, or some proximity
objects. This feature allows you to easily turn off or switch to an alternate pin via
external inputs. For instance, if your layout includes an external button for visitors
to control an animation, sharing the external input with a button lets you turn off
the external input. Button sharing has two types:

1. The button activates the designated pin, even if other pin users indicate Off.
2. The button only activates the designated pin if other pin users indicate On,

and this button itself indicates On.
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To illustrate the above, let’s assume we have an external input that controls two
pins, and it is set to Type 2 sharing as described. Additionally, let’s assume there is
a button of Type 2 associated with each pin.

Button 1 External Input Button 2

|Pin1| [pin1| [Pin2]| |Pin2|

In this case, Pin 1 and the animation associated with it will only be On if both
Button 1 and the external input are On. Similarly, Pin 2 and its associated
animation will only be On if both Button 2 and the external input are On.
Therefore, by simply manipulating Buttons 1 and 2, you can control what the
external input affects in real time, without changing the Control Panel setup.

3.5.4 Button Control Panel Operation

To activate a button in control panel mode, hover the mouse cursor over it and
press the Left Mouse Button. If the button is of the Momentary type, it will
remain active only while the Left Mouse Button is held down. If the button is of
the Latched type, it will stay On until the Left Mouse Button is pressed again while
the cursor is over it.

3.5.5 Practical Example

A basic example of using a button is illustrated below. In this demonstration, we
use a multimeter to show that the output connection functions as a switch. In the
Off state, the switch is open, resulting in an immeasurably high resistance. In the
On state, the switch is closed, and the resistance becomes very low. Additionally,
we will connect a simple LED circuit to illuminate an LED.

Step 1: Create a Layout
1. Launch the Grandpa’s Railroad Control Panel application.

2. Select Layout Setup mode.

68



3. Create a 10-inch by 10-inch layout in any scale.

o (Note: A layout does not need to contain track. In this example, we
are only adding a button.)

Step 2: Add a Digital/Proximity WiFi Module
1. Add a Digital/Proximity WiFi module to the layout.
2. Position it at 2 inches Horizontal and 5 inches Vertical coordinates.

3. Set the desired Connected and Not Connected colors.

WIFI Module Dialog x

WIFI Module Mumber

1

Ohject Location Center Point

Horizontal in inches Colors
2,000 WIFI Mot Connected _
Vertical in inches WIFI Connected

3.000

QK Cancel \

Step 3: Add a Latching Button
1. Add a Latching Button to the layout.
2. Position it at 5 inches Horizontal and 4 inches Vertical coordinates.
3. Set the width and height to 2 inches.
4. Add text to the button. In this example, we use On/Off as the label.
5. Select colors for the On and Off states.
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Button Dialog

Start Point Position Size Text Lines
Top Li Latching
Horizontal in inches Width in inches tHLE |
5.000 2.000 Middle Line | Button
Vertical in inches Height in inches
4,000 2.000
Bottom Line " MNone * onfoff 7 Custom
% Horizontal " Vertical Right " vertical Left
Button Type Colors
{* Latching

Button Off _ Button On
™ Momentary

Text Top Line Off Text Top Line On
Inverted Button
Upis OM Text Other Lnes Off Text Other Lines On
Down is OFF

[ Invert /1 Output [ Indude Border

OK Cancel ‘

Step 4: Connect the Hardware
1. Connect power to the WiFi Module.
2. Connect the card to the 9+ port on the WiFi Module.
3. Connect a multimeter to the +3 connector on the card.
o These connections provide a Pin #12 for the multimeter.

o The card used in this example is the Turnout Control & I/0O Board.
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Step 5: Switch to Control Panel Setup Mode

1. From the File Menu, navigate to:

B Grandpa's Railroad
File View Define Layout Help

Open Layout
Save Layout

Save Layout As
Prograrm Mode 3 Control Panel
Exit Control Panel Setup <4

Layout Setup

File/Program Mode/Control Panel Setup

2. This will switch to Control Panel Setup mode.

Step 6: Configure the Button
1. Place the mouse cursor over the button and press the Left Mouse Button.

2. Adialog box will appear.
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o Based on the connections from Step 4, the Module # is 1 and the Pin
#is 12.

o Since only one button is defined, the sharing type is not relevant.

Button Pin Connection =

Gt 0 Button Shared Use Characteristics
Mumber of Pins
B ry Pin may be activated by others
even if this button indicates OFF
WIFI Module Pin #

1 | 12| ¢~ Activate Pin only if this
button indicates OM

OK Cancel
Step 7: Switch to Control Panel Mode
1. From the File Menu, navigate to:

¥ Grandpa's Railroad
File View Define Layout Help

Open Layout

Save Layout

Save Layout As

Program Mode » Control Panel _

Exit Control Panel Setup

Layout Setup
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File/Program Mode/Control Panel

2. This will switch to Control Panel mode.

Step 8: Testing the Button

1. Once the Digital/Proximity WiFi Module connects, the screen should
resemble the following layout (if using the provided setup parameters and
colors).

Latching

M 1 Button

OFF

2. The multimeter should display 0.L, indicating an open circuit (no
connection).
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3. Press the Left Mouse Button over the button symbol.

Latching

M 1 Button
ON

4. The screen will update, and the multimeter will now read 0.4 ohms, which

is typical for a closed switch.
5. Additionally, a red LED next to the connector will light up, indicating that

the switch is On.
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If you have been following our Educational Tutorials: "Electricity 99", a more
practical application for model trains would be to use the button to control
lighting. By connecting a circuit from those tutorials, we can see how a button can
be used to turn lights on and off within the layout. Of course, in a real setup, the
battery pack would be replaced with the accessory power source.

Turnout Control & 1/0 Board
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3.6 Adding a Proximity Locator

A proximity locator on Grandpa’s Railroad is an infrared (IR) device used to
determine a train’s position or detect nearby objects. An IR device emits and
senses light within a wavelength range of approximately 800 nanometers to 1
millimeter. This light is invisible to the human eye and is generally emitted by
heated objects. The primary sources of IR radiation include the sun, heat lamps,
and conventional light bulbs, which can sometimes cause IR devices on model
railroads to function inconsistently.

Since Grandpa’s Railroad operates as a centralized system, sophisticated
algorithms continuously calibrate these devices, ensuring their stability and ease
of use.
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There are two primary methods for utilizing these devices:

1. Reflective Mode — Typically used for devices placed within the train tracks.
An IR LED transmits light, which reflects off a nearby object and is detected
by an IR sensor. The presence of reflected IR light at the sensor indicates an

object’s presence.

Surface

Reflective Proximity Sensor

2. Direct Mode — In this setup, the IR LED transmits light directly to an IR
sensor. When an object interrupts the beam, it signals the presence of an
obstruction.

J

.'
N

Direct Proximity Sensor

On a model railroad, the direct method can be used on opposite sides of a track to
detect trains.

3.6.1 Hardware Required
The hardware required to use proximity locators includes a Digital/Proximity WiFi

Module and one of the following options:

1. Screw-Type IR Proximity Locator Card

o IR Proximity Locator (included with the card)
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o Shrink tubing (included with the card)
o 4-wire telephone cable (solid wire)
o Wire strippers
o Soldering iron and solder or butt connectors
o Hair dryer or heat gun
o Screwdriver

or

2. RJ11-Type IR Proximity Locator Card

o IR Proximity Locator (included with the card)
o Shrink tubing (included with the card)
o 4-wire flat stranded 26 AWG telephone cord
o RJ11 6P4C male connector (ensure it is 6P4C)
o Wire strippers
o Soldering iron and solder or butt connectors
o Hair dryer or heat gun
o RJ11 crimp tool

The first step in preparing the hardware is attaching the wire to the IR LED and
sensor. The following steps outline the wiring process and methods we use. You
may find other methods easier, but it's important to ensure that the chosen
approach does not apply excessive heat to the IR LED or sensor. Additionally, the
final units should have a small enough diameter to fit into a 9/64-inch hole (see
Installing the Proximity Locator under Special Considerations).

3.6.1.1 Soldering Method of Wiring IR LED and Sensor

Step 1: Cut the appropriate cord to a length that reaches from the proximity
locator’s position on your layout to the designated pin on the IR Proximity Locator
card. It’s best to cut the cord slightly longer than needed to allow for some slack.
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Step 2: Strip 2.5 inches of the cable jacket from the cord. Then, strip %2 inch
of insulation from each wire. Twist the ends of each stranded wire to keep the
strands together.

or

Step 3: Tin each exposed wire end with solder. Apply a generous amount,
even to solid wires.
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Step 4: Cut a 5-inch piece of shrink tube into four equal pieces.

/T

Step 5: Once the solder has cooled, slide the shrink tube over each wire,
positioning it all the way to the cable jacket. Ensure the shrink tube remains away
from the soldering area during further steps.

Step 6: Using the diagram below, solder the correctly colored wire to the IR
device. Normally, you would heat the leg of the device before attaching the wire,
but in this case, apply minimal heat to the leg while heating the wire and solder
simultaneously. Keep the shrink tube away from the soldering area.
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Proximity Sensor Wiring
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The 45-degree corners on the case indicate the LED side of the case which we will
call the front. Therefore, when looking from the back to the front, the wiring is as

follows:

1) Front left — LED Anode (Red wire)

2) Front right — LED Cathode (Black wire)

3) Back left — Sensor Collector (Yellow wire)
4) Back right — Sensor Emitter (Green wire)

To solder, slightly bend the legs outward. If available, use a stand for support.

The final assembly should resemble the following:
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Step 7: Once the solder has cooled, carefully remove the LED and sensor
from the case. Slide the shrink tubing all the way up (keep the case for later
testing). To remove the LED and sensor, hold the case and press the top with a soft
plastic or padded item to avoid scratching the lens.

Use a hair dryer or heat gun to shrink the tubing, ensuring it extends fully
to the top. A hair dryer takes longer but reduces the risk of damaging the LED or
sensor. A heat gun may melt the plastic case if not used carefully.

a——

Step 8: Connecting the IR Proximity Locator to the card depends on the card
type:

e Screw Terminal Connection:

o Strip 1 inch of the cable jacket from the 4-wire telephone cable (solid
wire).

o Strip % inch of insulation from each wire.

o The connection to the card is as follows: the colors indicate the wire
colors, while the numbers represent the connection points. On the
card, positions 1 and 4 are marked to indicate the two endpoints.
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o Ensure the wire is not trapped under the connector. Fully open the
connector, insert the wire, tighten the connector, and check for a
secure connection. This prevents connection failures or intermittent
issues.

0L0ZZ-1ZIATYILE8Y0SC

e RIJ11 Connection:
o Strip % inch of the cable jacket.

o Use a crimping tool to attach an RJ11 6P4C connector to the wires.
The tool ensures proper wire orientation.

o Insert the connector into the appropriate slot on the card.
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RJASWiring | RJ11 -
L T568B 6P4C
i

T568R 6P6C

87654321/654321

Step 9: Reinstall the plastic case for the IR LED and sensor. Next, test the
setup using the example provided in a later section.

Best Practice: Keep a known working setup for testing components like cables
before installation. This approach helps identify issues early and saves significant
time and effort.

3.6.1.2 Butt Connector Method of Wiring IR LED and Sensor

Follow Steps 1 through 4 as outlined in the soldering method.
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Step 5: Slide a shrink tube over each wire, ensuring it reaches the cable
jacket. Then, slide a BNO.5 butt connector onto the end of each wire.

Step 6: Refer to the diagram below and crimp the correctly colored wire to
the corresponding IR device terminal. The case features 45-degree corners, which

Proximity Sensor Wiring

+10329]0) -
- J9wg
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indicate the LED side—this will be referred to as the front. Therefore, when
looking from the back to the front, the wiring is as follows:

1) Front left — LED Anode (Red wire)

2) Front right — LED Cathode (Black wire)

3) Back left — Sensor Collector (Yellow wire)
4) Back right — Sensor Emitter (Green wire)

To crimp, slightly bend out the legs.

Use a large set of pliers to apply high forc:w‘hen crimping the legs to the wire.
Additionally, flatten the butt connector so that the flat side is perpendicular to the
wire axis of the LED or IR sensor. This ensures that when the connector wires are
inserted through the hole under the track, their flat sides will face each other.

The final assembly should resemble the following:

Follow steps 7 through 9 as defined above for the soldering method.
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Best Practice: Keep a known working setup for testing components like cables
before installation. This approach helps identify issues early and saves significant
time and effort.

3.6.2 Adding a Proximity Locator to your Layout
From the main menu, select

fi Grandpa's Railroad
File View Define Layout Help

Define Layout Size and Type
Shift Layout
Define Custem Turnout
Define RFID Tags
Add Track Segment »
Add Other Component » Add Border Line
Add Button
Add Proximity Locator _
Add Proximity Locator Activated Object »
Add External Input Object »

Add RFID Reader
Add WIFI Module
Add Legend

Define Layout/Add Other Component/Add Proximity Locator
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Upon selecting this menu option, the following dialog will appear.

Proximity Locater Dialog X

Proximity Locator Mumber |0

Locator Position Locator Display Offset
Horizontal in inches Horizontal Offset in inches
0.000 0.000
Vertical in inches Vertical Offset in inches
0.000 0.000
Type
(+ Reflective ™ Direct
oK Cancel

In this dialog, you must enter the following data:

o Proximity Locator Number — A unique number between 1 and 999 assigned
to this device. This number is used to identify the device for interaction with
Proximity Objects.

» Locator Position — The point on your layout where the locator is installed.
This serves as the trigger point for the device.

« Locator Display Offset — An adjustment to the locator’s displayed position
on the screen. In rare cases, the actual device location may overlap with
another layout display element, so this offset allows you to move its on-
screen representation without affecting its real position.

o Type — The implementation method of the device:
o Reflective — Typically used for devices placed inside train tracks.

o Direct — Used when an IR LED transmits directly to an IR sensor, with
beam interruption indicating an object. On a model railroad, this
setup may be placed on opposite sides of a track to detect trains.
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Once you select OK in the Proximity Locator dialog and have entered all required
data correctly, a circle will be placed on the layout. If the data is incorrect, a
detailed error message will explain the issue.

To edit a proximity locator, left-click on the proximity locator element, select Edit
Location, and the dialog will reappear. (See Show Edit Locations for more details.)

3.6.3 Setting Up a Proximity Locator for your Control Panel

To set up a Proximity Locator for your layout, you must be in Control Setup mode.
Using the Left Mouse Button, click on the Proximity Locator image in the layout,
and the following dialog will appear.

Proximity Locater Contrel Dialog *

Proximity Locator Mumber # 1

Proximity Fin Number Filter Type MNeighboring Connections
WIFI Module # | 1 " None Proximity Locator
Fin # 0 (" Shortest Delay
{* Mot Used (" Straight ¥ {turnout)
" Short Delay

" Medium Delay
Trigger Level

’07 " Mormal Delay

" Long Delay

(" Extra Long Delay

Proximity Locator

* Mot Used (" Straight ¥ (turnout)

CKE Cancel ‘

Entering the Digital/Proximity WiFi Module Number

You must enter the Digital/Proximity WiFi Module number to which the
Proximity Locator card is connected. This number corresponds to the actual
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number programmed into the WiFi Module. Use the WiFi Module Programmer
software to assign this number.

Note: You must use the WIFI Module Programmer software to

program that number and your router name and password into
each module.

Calculating the Pin Number
The Pin # is determined by adding:

« The connector number on the Digital/Proximity WiFi Module where the
ribbon cable is attached.

« The Proximity Locator connector number on the card being used.
7

+S
/1 1exbia

Jojeroy - F
Awixoiy y

For example, using the image above, we calculate the Pin # as follows:
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« 1 (from the Digital/Proximity WiFi Module)
o +1 (from the board)
o Total=2

Thus, we would enter 2 for the Pin #.

Setting the Trigger Level

The Trigger Level defines the threshold at which the Proximity Locator detects an
object (e.g., a train). Since each locator and installation vary, you should set this
value based on observed results and adjust accordingly. (See 3.6.4 Proximity
Control Panel Operation for data plotting.)

A typical starting value is 10.
Filter Type Selection

The Filter Type allows you to apply predefined filters instead of using a direct
calibrated value to determine when an object is detected. Filters smooth out
transitions between "On" and "Off" states.

For instance, gaps between train cars might momentarily register as "Off." Using a
filter prevents this, ensuring a smoother result. The delay length represents how
much smoothing occurs. The ideal filter depends on installation factors such as
scale, car type, speed, etc.

To determine the best filter, experiment visually in Control Panel mode by viewing
the plotted data with different filters applied versus the Trigger Level.

Neighboring Connections Group Box

The Neighboring Connections Group Box defines the closest Proximity Locators
on either side of the current locator, helping to establish a connectivity network.

If an RFID reader is used to identify a locomotive, this network allows tracking as
the locomotive moves across the layout. While this data is optional, it is required
when using RFID readers.

There are two types of network connections:
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1. Straight Connection

o Inthe diagram below, Proximity Locator #2 has two straight
connections: one to #1 and one to #3.

o This would be entered in the dialog as follows:

—Meighboring Connections

—Proximity Locator

™ NotUsed ¥ Straight ¥ (turnout)

Proximity Locator # I 1

—Proximity Locator

™ Mot Used i Straight ™ ¥ (turnout)

Proximity Locator # | 3

2. Y (Turnout) Connection
o Inthe second diagram, Proximity Locator #2 has:

1. A straight connection to #1.
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2. AY (Turnout) connection to #3 and #5 via Turnout #1, as a
locomotive could travel either down the mainline (#3) or the
sideline (#5).

o This would be entered in the dialog as follows:

—Meighboring Connections

— Proximity Locator

™ Mot Used ¥ straight i~ ¥ (turnout)

Proximity Locator # I 1

—Proximity Locator

" Mot Used " Straight & ¥ (turnout)

Proximity Locator # |3 Main Turnout Line

Turnout # I 1
Proximity Locator # I 3 Side Turnout Line

If we further look at this example, Proximity Locator #5 has a straight connection
to both #2 and #6. Even though a locomotive crosses a turnout at an angle, it is
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still considered a straight connection because there is only one possible next
Proximity Locator without changing direction.

Note: You can think of a straight connection as one that only has

one choice for its next proximity locator to pass overand a Y
connection having two choices.

If you install Proximity Locators on only part of your layout, and a locator is the
last one before a large gap, label one of the connections as "Not Used."

3.6.4 Proximity Locator Control Panel Operation

The proximity locator will turn on or off depending on the calibrated (or filtered)
value of the trigger level. By default, the locator appears white but will change to
black (or a preselected color if an RFID reader is used to track a locomotive) when
an object is detected.

For a deeper understanding of its operation, click the Proximity Locator image
using the Left Mouse Button to open a dialog that allows you to plot the sensor’s
data.

Dizlog >
Time Period To Plot Type
{* 10 Seconds {* Continuos
" 20 Seconds £ One Pass
(" 30 Seconds

Data To Plot

Ok
[v Trigger Level

[+ Raw IR Data

[v Calibrated IR Cancel
[v Filtered IR
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» Time Period to Plot adjusts the time axis of the plot.

« Type determines whether the plot scrolls continuously or displays a single
time-segment pass that stops upon completion.

o Data to Plot enables the visualization of various data sets:
o Raw IR data recorded by the sensor (black)

o Calibrated version of the data (blue)

o Filtered version of the data (green), based on the selected filter in
Control Setup mode

o Object presence trigger level (red)

Below is a sample plot showing a train passing over a proximity locator.

Proximity Locator Number #3
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| AU =l )
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| \! \;\ D’ \ i\ \ £ {\ f*\ . .»’f \\ | fx: A\
60 ! U\ ’ / \ "__;”ﬁ* I o .”ﬁ A e IfX/_\\ '( | — \
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| \ i | L /A ‘\
“ I i H/EEENEE B AT T
| i ‘W’ BRIV
| \' | \\ ) \ﬁ . | i
20~ .‘ | \ 4 4 V \ L@_f‘} M | \
0, 5 ! | | |

Seconds
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Since the proximity locator system digitally samples data, each train pass results in
different sampling points along the bottom of the train cars, leading to variations
in plots. The reflectivity of each car differs based on its color, shape, and height,
causing variations in detected patterns from car to car. To illustrate this, an
annotated version of the plot is provided.

Proximity Locator Number #3
100

80- / }\ l
|

o | '\I

40~ [ \/

Seconds

Locomotive #1 | Locomotive #2 Car #1 Car #2 Car #3 Car #4 Car #5 Car #6

You can observe the spaces between train cars. In some instances, the calibrated
reflectivity signal from the coupler drops below the trigger level. Without a filter,
the proximity locator would flicker between On and Off, which could affect both
the display and any proximity-based objects relying on it. However, in these cases,
the green line (filtered value) remains above the trigger level, preventing
unwanted flickering.

The filter delay setting determines the responsiveness of the filtered value:
« A shorter delay causes the green line to drop more quickly.

« Alonger delay slows the drop, allowing for customized adjustments.
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While understanding the precise workings of the filtering algorithms is not
necessary, experimenting with different filters and observing reflectivity across
various train cars can provide valuable insights into IR sensor behavior.

If you wish to adjust the trigger level or filter type during operation, click the
Proximity Locator image using the Right Mouse Button to open a dialog where
you can modify these settings.

Praximity Locator Contrel Dialog

Proximity Locator Mumber # 2

Proximity Pin Number Filter Type

WIFI Module # 1 {* None

Pin # 2 (" Shortest Delay
(" Shart Delay

" Medium Delay
Trigger Level

’17 ™ Normal Delay

" Long Delay

{" Extra Long Delay

oK Cancel ‘

3.6.5 Special Considerations

3.6.5.1 Mounting IR Proximity Locator in Your Track When mounting your
locator, it is essential to ensure that a barrier is placed between the IR LED and the
sensor. The plastic holder that comes with the unit includes a small barrier
between the two components to prevent direct IR transmission from the LED to
the sensor, which could result in false readings.

For N scale tracks, the units must be mounted parallel to the rails due to
width constraints. It is best to use a railroad tie as the barrier in this setup.

For HO scale tracks, the unit can be mounted either parallel or
perpendicular to the track. Mounting it parallel allows the use of a railroad tie as
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the barrier, while mounting it perpendicular requires ballast to serve as the

barrier. In all cases, ensure sufficient spacing between the rails and units, as well
as between individual units.

To install the units:

1. Use a 9/64-inch drill bit to drill two holes at slight angles, as illustrated
below.

ties

M =

- -
roadbed ;
layout base wood / : | \

P

" \ Countersunk

9/64 in

2. The exact angle of the holes is not critical, but they should intersect

approximately % to % inch up, depending on the scale. The underside of
the holes may be countersunk for easier installation.

3. For N scale, you may need to remove part of a railroad tie to drill the holes.

4. Run the drill up and down several times to clean out the hole, allowing the
units to slide in snugly.

After installation, test each unit and adjust the LED and sensor height for

optimal performance. Once satisfied, secure them with a small amount of hot
glue underneath.

To practice and experiment, we recommend building a short section of
track and roadbed on a test board before final installation.
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3.6.5.2 Determining the leads of the IR LED and Sensor

If the LED, sensor, or both become loose from the case before wiring, follow
these steps to determine the correct wiring:

For the LED (light blue element):

1. Set your multimeter to the diode setting. @ Bt (For the multimeter
shown in our "Electricity 99" series, turn the dial to the Q position and press
the Select button until the diode symbol —t— appears.)

2. Connect the two leads to the LED.
o If the multimeter displays .0OL, switch the leads.

o In one of the two lead connections, you should get a reading slightly
over 1 volt.

3. In this position, the red lead of the multimeter is connected to the LED
anode, and the black lead is connected to the cathode.

4. Wire these leads exactly the same way.
Wiring Instructions:
o Connect the black phone cord wire to the Cathode.

o Connect the red phone cord wire to the Anode.

Cathode -
Anode +

For the Sensor (dark purple element):
1. Set your multimeter to the Q (ohms) setting.
2. Connect the leads to the sensor.

o If the reading is erratic or fluctuates, or if it shows .OL when you place
your finger over the sensor, switch the leads.
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o In one of the two lead connections, you should observe the following
readings:

= Approximately 150 kQ with your finger over the sensor
= Approximately 15 kQ in normal room light
= Between 250Q and 1 kQ in direct sunlight
When these readings are obtained:
« Thered lead of the multimeter is connected to the sensor collector.
o The black lead of the multimeter is connected to the sensor emitter.
Wiring Instructions:
o Connect the green phone cord wire to the emitter.

o Connect the yellow phone cord wire to the collector.

Emitter -
Collector +
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3.6.5.3 Effect of sun on IR Proximity Locator The sun is a significant source
of infrared (IR) light and, as expected, has a considerable impact on the readings
from a proximity locator. When we analyze the performance of the IR Proximity
Locator under direct sunlight, we observe the following:

1]
Proximity Locator Number #1

100+

80+
Raw data
60
40+
20 Calibrated data
% 2 4 6 8 10

Seconds

Notably, the raw data line remains around 98, well above the trigger line.
However, the calibrated data is approximately 2, which is well below the trigger
threshold. This raw data behavior highlights why many people are hesitant to use
IR sensors. By centralizing our processing in a main computer, we can apply
algorithms to calibrate the sensors effectively.

The plot below illustrates data from an N-scale layout, where part of the
layout was exposed to sunlight while a train passed by.
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Proximity Locator Number #31
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Calibrated data

Without calibration, the raw data would have continuously triggered the reflective
locator. However, the calibrated and filtered data demonstrate flawless operation,
accurately detecting the train as it moves through the layout.

3.6.6 Practical Example
The following example demonstrates the use of an IR Proximity Locator. In this

example, we add only a Digital/Proximity WiFi Module and a single Proximity

Locator.

Step 1: Prepare the Hardware

Set up the hardware as outlined in the Hardware Required section above. Ensure
the plastic case is properly reinstalled.

Step 2: Add a Digital/Proximity WiFi Module

Integrate a Digital/Proximity WiFi Module into your layout, following the
instructions in the Adding a Digital/Proximity WiFi Module - Practical Example

section.

Step 3: Add a Proximity Locator
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Position the Proximity Locator at 6 inches horizontally and 5 inches vertically on
the layout. Set the Type to Reflective.

Proximity Locator Dialog *

Proximity Locator Mumber | 1

Locator Position Locator Display Offset
Horizontal in inches Horizontal Offset in inches
5.000 | 0.000
Vertical in inches Vertical Offset in inches
5.000 | 0.000
Type
* Reflective (" Direct
QK. ‘ Cancel ‘

Step 4: Enter Control Panel Setup Mode
From the File menu, select:

¥ Grandpa's Railroad
File View Define Layout Help

Open Layout

Save Layout

Save Layout As
Program Mode ] Control Panel
Exit Control Panel Setup _

Layout Setup

File/Program Mode/Control Panel Setup
This will switch the system to Control Panel Setup Mode.
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Step 5: Configure the Proximity Locator

o Using the left mouse button, click on the Proximity Locator image in the
layout. A dialog box will appear.

o Enter the required data in the dialog.

Proximity Locator Contrel Dialog x
Proximity Pin Mumber Filter Type
WIFI Module # |1 " Mone
Fin # lzi (" Shortest Delay
" Short Delay
* Medium Delay
Trigger Level C Normal Delay
10
" Long Delay
(" Extra Long Delay
OK Cancel

Step 6: Switch to Control Panel Mode

From the File menu, select:

fi Grandpa's Railroad
File View Define Layout Help

Open Layout
Save Layout

Save Layout As
Prograrm Mode * Control Panel _
Exit Control Panel Setup

Layout Setup
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File/Program Mode/Control Panel

This will switch the system to Control Panel Mode, and the
Digital/Proximity WiFi Module should establish a connection.

Step 7: Define the Proximity Locator Plot

o Click on the Proximity Locator image in the layout using the left mouse
button.

o Adialog box will appear, allowing you to define the Proximity Locator Plot.

o Enter the required data and click OK.

Dizlog *
Time Period To Plot Type
* 10 Seconds * Continuos
" 20 Seconds © One Pass
" 30 Seconds

Data To Plot
Ok

v Trigger Level
v Raw IR Data

[v Calibrated IR Cancel
[+ Filtered IR

Step 8: Test the Sensor

« Wave your hand approximately 1 inch in front of the sensor. The screen
should update accordingly.

« Experiment with different filters, lighting conditions, and other parameters
to observe changes in detection performance.
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3.7 Adding Gate, Signal, or Animation

Adding a gate, signal, or animation to Grandpa’s Railroad follows a straightforward
process. We provide the necessary tools to configure the ON or OFF conditions for
lights, gates, or any other animations triggered by proximity locators. The
following sections will guide you through using these tools effectively.

3.7.1 Hardware Required
The simplest form of animation control involves operating a light or another
external electrical device. To achieve this, you will need at least one output pin on
either an Input/Output Card or a Turnout Control & 1/0 Board. The B
output pins on these boards function as switches for AC or DC ﬂ@F
current.

|

Below is a basic schematic demonstrating
how to connect a light to an output pin:

sanduj

|l

F—

HER
Outputs

Input / Output Card
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For a deeper understanding of electricity, voltage, and current, refer to the

educational tutorial "Electricity 99."

3.7.2 Adding a Gate, Signal, or Animation to your Layout

To add an animation to your layout, you must enter Layout Setup mode. From the

main menu, navigate to:
ffi Grandpa's Railroad

File View DefineLayout Help
Define Layout Size and Type

Shift Layout
Define Custom Turnout
Define RFID Tags
Add Track Segment ¥
Add Other Component > Add Border Line
Add Button
Add Proximity Locator
Add Proximity Locator Activated Object >
Add External Input Object ¥

Add RFID Reader
Add WIFI Module
Add Legend

Gate, Signal, or Animation _

Collision Avoidance

DCC Event or Sequence

Define Layout/Add Other Component/Add Proximity Locator Activated Object/Gate, Signal, or

Animation

Upon selecting this menu option, the following dialog box will appear:

Gate or Light Prosamity Object Dialog

Proximity Object Mumber | O

Object Location Center Point Colors

Horizontal in inches Button Off

0.000 Button On

x

Vertical in inches

0.000

Ok

Cancel
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This dialog allows you to configure the Proximity Object number, position, and
ON/OFF colors.

o Proximity Object Number: A unique number between 1 and 999 assigned
to this object.

o Object Location Position: The center point where the circular indicator will
be placed on the layout.

o Colors: This section lets you customize the ON and OFF colors of the button.
Clicking either color button opens a selection dialog.

Color
Basic colors:

B W=

FETHNE N

FEEENEN

EEEEERN

EEEEERN

A B NN S
Custom colors
EEEEEEER

Hue: [160 Hedl_

EEEEEEER Satlﬂ'_ Gren:[i

| ColoriSolid |,y [0 Buue:[0
QK | Cancel | Add to Custom Colors |

After configuring these settings, click OK in the Gate or Light Proximity Object
dialog. If all required data has been entered correctly, a circle representing the
object will appear on the layout. If there are errors, a detailed message will
explain what needs correction.

To edit a gate, signal, or animation object, simply left-click on it, and the dialog will
reopen, allowing you to make modifications.

3.7.3 Setting Up a Gate, Signal, Animation Object

To configure a Gate, Signal, or Animation Object in your layout, you must first
enter Control Setup mode. Once in this mode, click on the Gate, Signal, or
Animation image using the Left Mouse Button. This action will open a
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configuration dialog, allowing you to customize how the object interacts with the
system.

Light, Gate, or Animaticn Dialog X

Qutput Elements

Mumber of Murmber of ) Number of
Proximity Locators 2 Elements | 2 Element Type output Pins WIFI Module Pin #
#1
On if any of my Proximity Locators (PLs) On 1 o
Directional Object o v Y t (L)

if anv of mv PLe On but no other element On

n if a e
I”" Directional F
3

Used by Element Used by Element

0 W #1

Example: Crossing Flasher with flashing Card:
N of Sements = 1 camce
Element Type = " On if any of my Proximity Locators (PLs) On ™

Check Directional

Note: This dialog has been designed so that many different
features can be controlled by it. For this reason, we realize that its
use can be difficult to understand. Therefore, we will provide two
detailed examples at the end of this section, one adding a crossing

flasher which has a flasher card and two adding a green, yellow,
red train traffic signal. After reading this section, refer to those
examples for a better understanding of some of these elements.

Configuring Proximity Sensors and Output Elements

In the top-left section of the dialog, you will find fields to define the number of
proximity sensors that will control this object, as well as the number of output
elements the object will manage. The number of output elements depends on the
type of device being controlled.
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For example, if you are controlling a crossing flasher with a flasher card, the
number of output elements should be set to 1, as it functions as a simple on/off
device. However, if the object being controlled is a train traffic signal that features
green, yellow, and red lights, then typically 3 output elements would be
required—one for each color. Some train traffic signals are designed so that when
neither the red nor yellow lights are active, the green light is automatically
illuminated. In such cases, only 2 elements are necessary instead of 3.

Directional Control Option

Below this section, there is an option to enable directional control, which allows
the object to activate only when a train moves in a specific direction. If this option
is selected, the dialog will update to include fields for two proximity locators. The

Directional Object
[+ Directional

Start Locator 0 Decision Locator u]

system determines the direction of the train by the order in which these locators
are triggered. If the start locator is activated before the decision locator, the
object will respond accordingly. However, if the order is reversed, the object will
not activate.

Although most model train crossing flashers currently available operate in a non-
directional manner, using directional control can significantly improve realism. We
will provide examples demonstrating how this setting enhances accuracy without
requiring additional hardware.

Example Configurations

o The dialog interface will change depending on the number of proximity
locators and output elements selected. If, for example, you choose 12
proximity locators and 1 output element, the configuration will display
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—Locator Mumbers

Used by Element Used by Element

WV #1 IU ¥ #1
W #1 IU W =1

¥ #
W #1
¥ #
¥ #1
¥ #1
W #1

W #1

W 21
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differently compared to a selection of 12 proximity locators and 3 output
elements.

—Locator Mumbers

Uszed by Element Uged by Element
V221 W2 v 23 IU W1 W2 ¥ 23
¥ #21 W #2 ¥ #3 IU Wzl W2 ¥ 23

V=1 Wz2 Wz
V#1 Wz [ %3
#21 ¥ #2 W £3
V2 W#2 Wz
VF# Vs W
V=1 Wz2 Wz

W1 W22 W23

W 21 ¥ 22 W 23

AN
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When configuring 1 output element, all proximity locators will typically be
selected by default. If certain locators are unnecessary, they can be removed from
the list to streamline functionality. In the case of 3 output elements, the dialog
will initially check all locators for all elements. However, not all locators need to
control every element, and adjustments should be made depending on the
application. For further insight, refer to Section 3.7.5.3: Three-Color Train Traffic
Signal, which provides a practical example of how these settings are applied.

Configuring Output Elements

The final section of the dialog is where you define the output element type and
configure its connection settings. If you have 3 output elements, the dialog will

display three corresponding rows, each representing a separate output. If there
are only 2 output elements, the dialog will show only the top two rows, and if
there is just 1 output element, only a single row will be visible.

Output Elements

| MNumber of )
Element Type output Pins WIFI Module Pin #

#1 FEM_
On if any of my Proximity Locators (PLs) On | 1 0
On if anv of mv PLs On but no other element On

#2 0n if any of my Proximity Locators (FLs) On | L | 0
On if anv of mv PLs On but no other element On

#3
On if any of my Proximity Locatars (PLs) On | 1 | ]
On if anv of mv PLs On but no other element Cn é
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Understanding Output Element Types

There are seven different element types, each defining specific conditions that
determine when an output element will be activated. These types allow for
greater control over how signals, gates, and animation objects behave in response
to train movements.

Type Meaning

Not a valid type indicating not defined yet. You
Undefined will not be able to leave the dialog without
defining it.

This is the most common type and indicates that
On if any of my Proximity Locators (PLs) On | the element will be on if any of the proximity
locators assigned to it are on.

For this option the element will only be on if one
of the proximity locators assigned to it is On but
none of the other elements for this object is On.

On if any of my PLs On but no other
element On

This is a unique case that causes the element to
On if no other element On be On if no other element is On. This is useful for
lighting the green light on train traffic signals.

This causes an element to flash at a 0.5 sec rate if
Flash Element every 0.5 sec if any of my any of its assigned proximity locators is On. It is
PLs On useful for creating a crossing flasher when you
don’t have a flasher card.

This causes an element to flash at a 1.0 sec rate if
Flash Element every 1.0 sec if any of my any of its assigned proximity locators is On. It is
PLs On useful for creating a crossing flasher when you
don’t have a flasher card.

This causes an element to flash at a 1.5 sec rate if
Flash Element every 1.5 sec if any of my any of its assigned proximity locators is On. It is
PLs On useful for creating a crossing flasher when you
don’t have a flasher card.

More details about these output element types can be found in Section 3.7.5:
Practical Examples, where practical implementations are discussed.
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Completing the Setup Process

Once you have entered all the required settings, click OK to finalize the
configuration. If any information is missing or incorrectly entered, an error
message will appear, providing details about what needs to be corrected before
proceeding.

By following these steps, you can successfully configure gates, signals, and
animation objects to enhance your layout, ensuring accurate and realistic
responses to train movements.

3.7.4 Gate, Signal, Light Object Control Panel Operation

The Gate, Signal, and Light Object is activated by one of its proximity sensors. The
control panel color will shift from the OFF state to the ON state. Additionally, the
object elements will function according to the specified setup.

3.7.5 Practical Examples

To illustrate and clarify the use and setup of this object, we have selected three
examples. The first is a crossing flasher, which uses a flasher card to control its
flashing. The second example is similar to the first, but without a flasher card. The
third example is a three-color (red, yellow, green) train traffic signal.

3.7.5.1 Crossing Flasher with Flasher Card
Suppose we want to create a crossing flasher for a road crossing over a single train
track, as illustrated below.

Crossing Flasher

@ @ ® @ ® ® @ ®

< Train Direction >

One method to achieve this is by defining a non-directional Gate, Light, and
Animation object. In this approach, we would use locators 2 through 9, and the
element type (On if any of my Proximity Locators (PLs) are ON). To set up this
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method, the control panel setup dialog would appear as follows:

Light, Gate, or Animation Dialog

Output Elements

Mumber of 7 Number of | MNumber of
Proximity Locators Elements | 2 EemeniinT e output Pins WIFI Module Pin #
#1 Undefined
On if any of my Proximity Locators (PLs) On 1 0

Directional Object On if anv of mv PLs On but no other element On
I” Directional FZ
3

Locator Numbers

Used by Element Used by Element

<
4+

Example: Crossing Flasher with flashing Card:
I #1 Number of Elements = 1 Cancel
Element Type = *On if any of my Proximity Locators {PLs) On *

W #1 Chedk Directional

T

The disadvantage of this method is that while the flasher turns on a sufficient
distance from the crossing, it will not turn off until long after the train has passed.
This behavior mirrors how hardware implementations for crossings operate.

A more realistic approach would be to create two directional Gate, Light, and
Animation objects. Both objects would control the same output pin to turn the
flasher on and off, requiring only two additional proximity locators (#1 and #10).
This results in a more realistic behavior.

Crossing Flasher

@ @ ® @ ® ® @ ®

[ Train Direction >
< Train Direction
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Based on the layout above, the dialog for the object controlling a train moving

from left to right would be:

Light, Gate, or Animation Dialog

Number of 5 MNumber of
Praximity Locators Elements 2

~Directional Cbject

[V Directional

Start Locator 1 Decision Locator I 2

r~Locator Numbers
Used by Element

W 1
W #1
¥ #1
#1
¥ #1

W =1

111

Used by Element

—Output Elements

a Mumber of )
ement Type output Pins WIFI Module Pin #

#1  [Undefined
On if any of my Proximity Locators (PL: 1 o

On if anv of mv PLs On but no other element On
2
3

Example: Crossing Flasher with flashing Card:
Mumber of Elements = 1 Cancel
Element Type = * On if any of my Proximity Locators (PLs) On *

Check Directional

The dialog for the object controlling a train moving from right to left would be:

Light, Gate, or Animation Dialog

Number of 5 Number of
Proximity Locators Elements

el

i Directional Object
[V Directional

Start Locator 10 Decdision Locator 9

rLocator Numbers

Used by Element
F #
F #
¥ #1
¥ #1
P #

W #

TTTTT7

Used by Element

[~ Output Elements

5 Number of
ement Type output Pins WIFI Module Fin #

#1 | Undefined
On if any of my Proximity Locators (PLs) On |1 o

On if anv of mv PLs On but no other element On
2
3

Example: Crossing Flasher with flashing Card:
Nember of emerts = 1 cance
Element Type = " On if any of my Proximity Locators (PLs) On ™

Check Directional
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Note: Since proximity locators are independent of any specific
function, they can be used multiple times servicing many functions.

A single locator could be used for signals, collision avoidance, DDC

events, etc.

For a crossing flasher with two parallel tracks, we could define two additional
directional Gate, Light, and Animation objects. These would control the same pin
and use the proximity locators from the second track.

3.7.5.2 Crossing Flasher without Flasher Card

Assume we have the same layout as above for a crossing flasher over a single train
track, but without a flasher card. In this scenario, we must control each light of the
flasher independently, which requires two output elements—one for each light.
The dialog for setting up the object for a train moving from left to right would be

as follows:

Light, Gate, or Animation Dialog

Output Elements

Element Type

Number of 5 Number of [ 1
Proximity Locators Elements
Directional Object
W Directional
Start Locator 1 Decision Locator 2

#1 Flash Element every 0.5 sec if any of my PLs On
Flash Element every 1.0 secif any of my PLs On
Flash Element everv 1.5 secif anv of mv PLs On

Locator Numbers

Used by Element Used by Element
bz W 22
v z1 | 22

V1 V22

<l
<l
44

2

<l
<
+

2

11117

<
*

On if any of my PLs On but no other element On
#2 | Onifno other Element On
Flash Element everv 0.5 secif anv of mv PLs On

Number of X
output Pins WIFI Module Fin #
1 1
2
3
R

Example: Crossing Flasher with flashing Card:
Mumber of Elements = 1
Element Type = "On if any of my Proximity Locators {(PLs) On ™
Check Directional
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Key points to note in the dialog above:

1. Set the number of elements to 2.
2. Select all proximity locators to be used by both elements.
3. Set the element type for the first element to: Flash Element every 1.0 sec if
any of my PLs are On (0.5 or 1.5 seconds could also be used).
4. Set the Pin # for the first element to 1 (representing the hypothetical pin
connected to the first flasher light).
5. Set the element type for the second element to: On if any of my PLs are
On, but no other element is On.
6. Set the Pin # for the second element to 2 (representing the hypothetical pin
connected to the second flasher light).
Setting up the object in this manner will cause the first light to flash on and off at
1-second intervals, while the second light will turn on only when the first light is
off.

3.7.5.3 Three Color Train Traffic Signal
Assume we want to add a red, yellow, and green train traffic signal to a track, as
illustrated below:

O @ ® @ ® ® @ ®

< Train Direction >

Additionally, we want the signal to indicate red when the train is near proximity
locators 1 through 8, and yellow when the train is near proximity locators 9 or 10.
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The setup dialog for a Gate, Signal, or Animation Object to achieve this is shown
below:

Light, Gate, or Animaticn Dialog

Output Elements
Mumber of 9 Mumber of | 2 ) MNumber of )
Proximity Locators Elements Element Type output Pins WIFI Module Pin #
#1 | Undefined
- - On if any of my Proximity Locators (PLs) On 1 1
Directional Object On if anv of mv PLs On but no other element On
[" Directional 2
3
On if any of my Proximity Locators (PLs) On ’— ’—
e iomes 23 COn if any of my PLs On but no other element On t 2

Onif ther El it O
Used by Element Used by Element oo F
3
W ozi [ #2 [ #3

Max1 [T 22 [ %3

23 On if any of my PLs On but no other element On
On if no other Element On

1 3
M#t [ # [ %3 Flash Element everv 0.5 secif anv of my PLs On F
3

4

Example: Crossing Flasher with flashing Card:
v M2 [ #3 Number of Elements = 1 oK | Cancel ‘
Element Type =" On if any of my Proximity Locators (PLs) On ™

Check Directional

<]
*®
1
a
]
1
a

4+
<
at
[}
it

T

4+
<
at
[}
it

If we connect element 1 to red, element 2 to yellow and element 3 to green, the
items to note in the above dialog is that we have:

[y

. Set the number of elements to 3.

Check proximity locators 1 through 8 in the first column (red).

. Set the element type for #1 to: "On if any of my Proximity Locators (PLs)
are On."

4. Set the WIFI and Pin # to which the red element is connected.

. Check proximity locators 9 and 10 in the second column (yellow).

. To ensure the yellow light does not activate when the train is still occupying
locators 1 through 8, set the element type for #2 to: "On if any of my PLs
are On, but no other element is On."

7. Set the WIFI and Pin # to which the yellow element is connected.

8. Ensure no proximity locators are checked in the third column (green).

9. Set the element type for #3 to: "On if no other element is On."

10.Set the WIFI and Pin # to which the green element is connected.

w N

o U
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By configuring the object in this manner, the green light will turn on when none of
the 10 proximity locators are activated, the red light will turn on when any of
locators 1 through 8 are activated, and the yellow light will turn on when locators
9 or 10 are activated, provided locators 1 through 8 are not activated.

3.8 Adding Collision Avoidance

Collision Avoidance on Grandpa’s Railroad is designed to prevent trains from
colliding with obstacles on the tracks or derailing when entering a switch set in the
wrong direction. In both cases, the system works by automatically cutting power
to the track section (Block) that the train is currently occupying. (Refer to Section
3.1.1 for a discussion of Blocks.)

3.8.1 Hardware Required

To implement collision avoidance, the track must be connected to a block control
card. The installation and configuration of this card are discussed in Section 3.1.
Additionally, two proximity locators are required for each leg of a turnout to
enable turnout collision avoidance, and three or more locators are needed for
each track segment for track-occupied collision avoidance. Before moving forward
with setting up these features, the relationship between the proximity locators
and the track will be explained.

3.8.1.1 Turnout Collision Avoidance Hardware Location Three scenarios for
positioning proximity locators relative to turnouts will be discussed.

The first scenario involves a simple turnout, as shown below:
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Decision Locator Start Locator

’ ’

— o o
- o o
Decision Locator Start Locator

To fully cover this situation, two collision avoidance proximity objects need to be
defined, one for each leg of the turnout. Each object must have a start locator and
a decision locator. The decision locator should always be positioned closer to the
turnout to help determine both the direction of travel and motion. If the train is
moving away from the turnout, power should not be cut to the track. Likewise, if
the train is stationary, power should not be cut.

It’s crucial to place the decision locator far enough from the switch so that the
train can coast to a stop before reaching the switch when power is cut. The
distance required may vary depending on the type of track, such as a high-speed
mainline versus a siding. If multiple control blocks are involved, as depicted below,

oy ® ®
Deciszn Locator Star‘t\Locator

the decision locator should be placed far enough from the end of the block so that
the train does not coast into the next powered block. In this case, the decision
locator should be placed far enough from the end of the green control block to
ensure the train stops before reaching the powered red block.

The second scenario involves paired turnouts. In this example, although two
turnouts are used, there are only two potential derailment situations because the

Decision Locator Start Locator
Start Locator Decision Locator
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turnouts are paired. The turnouts will change together to ensure the crossover
situation remains correct. Two collision avoidance proximity objects would still
need to be defined, covering the two legs, with locators positioned according to
the same rules as in the first scenario.

The third scenario occurs when a turnout is positioned directly in front of another
turnout, as shown below. In this case, if the turnouts are aligned as shown in the

Decision Locator Start Locator

v

first image, a derailment situation would occur, and power should be cut.
However, if the turnouts are aligned as shown in the second image, no derailment
would occur, and power should not be cut. To address this, the use of a second
turnout during control panel setup can be considered, which will be discussed
later.

Decision Locator Start Locator

3.8.1.2 Track Occupied Collision Avoidance Hardware Location Two scenarios
for positioning proximity locators relative to track block positioning will be
discussed.

The first scenario is the simple case of moving from one track block to another, as
shown below. As with turnout collision avoidance, both the direction of travel and

o o o o
Start Locator Decision Locator

the motion of the train are important. Power should not be cut if the train is
traveling away from the green block or is stationary on the red block. However, if
the green block is occupied, the train should stop. One or more proximity locators
can be placed on the green block to detect occupancy. The higher the sensor
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density, the smaller the obstruction that can be detected. For example, if you're
trying to determine whether a long train is occupying the segment or just a single
car, the sensor density should be adjusted accordingly. As with turnout collision
avoidance, the decision locator should be placed closer to the end of the block
than the start locator, but far enough away to give the train enough distance to
coast to a stop before reaching the powered green block. The diagram above
shows protection for occupancy only on the green block. If protection is needed
for the opposite direction (for a train traveling from the green block to the red
block), a second track-occupied collision object must be defined. This may not
require additional resources or wiring, as Grandpa’s Railroad proximity locators
are not dedicated to a specific function. The same locators used for occupancy
detection on the green block can also serve as the start and decision locators for
the opposite direction.

The second scenario occurs when a turnout is positioned before the occupied
block, as shown below. In this scenario, occupancy detection should focus on the

e

Start Locator Decision Locator

green block only if the turnout is in the mainline position. However, if the turnout
is switched, blue block occupancy should be considered instead. If the switch
position changes, green block occupancy should be prioritized. During control

o o — ® o
f 1 ® ®
Start Locator Decision Locator

panel setup, the turnout direction can be specified to handle this situation. To

Decision Locator Start Locator

) ’

o @ — o @
o o
o o ® o
‘
O
Decision Locator Start Locator
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cover the two possible switch positions, two track-occupied proximity objects
must be defined, as the locators will differ based on the switch configuration. If
track occupancy collision avoidance is required in the opposite direction, two
additional track-occupied collision avoidance objects must be defined for the
scenarios below. As with previous examples, no extra resources or wiring may be
necessary, as Grandpa’s Railroad proximity locators are not dedicated to a specific
function.

3.8.2 Adding a Collision Avoidance Object to your Layout
From the main menu select

E Grandpa's Railroad
File View Define Layout Help
Define Layout Size and Type

Shift Layout

Define Custorn Turnout

Define RFID Tags

Add Track Segment >

Add Other Component ¥ Add Border Line

Add Button
Add Proximity Locator

Add Proximity Locator Activated Object ¥ Gate, Signal, or Animation
Add External Input Object ¥ Collision Avoidance _
Add RFID Reader DCC Event or Sequence

Add WIFI Medule
Add Legend

Define Layout/Add Other Component/Add Proximity Locator Activated
Object/Collision Avoidance

Upon selecting this menu item, the following dialog will appear.
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Collision Object Dialog et

Proximity Object Mumber | O

Object Location Position Object Type
Harizontal in inches m
Vertical in inches =
0.000 Button Off | _

owencn |

QK Cancel ‘

Input Data Requirements

Using this dialog, you must enter the following information:

Proximity Object Number: A unique identifier between 1 and 999 for this
object.

Object Location Position: The placement of the object symbol (a square) on
your layout. It is recommended to position the symbol near the location
where avoidance is utilized. For instance, if it is a turnout collision
avoidance object, place it next to the turnout it affects. This ensures that in
case of an avoidance event, the flashing symbol will indicate the problem’s
location.

Object Type: Choose between "Turnout Collision Avoidance" or "Track
Occupied Collision Avoidance."

Colors: Customize the "On" and "Off" colors of the collision avoidance
signal. If collision avoidance is manually disabled, the "Off" color is
displayed; otherwise, the "On" color appears. Different colors can be set for

125



each type to help distinguish them. Clicking either button will open a color

selection dialog.
X

Hue: 'I Red: {I'
Sat: ﬂ' Green.lﬂ
Crefine Custam Colars =3 ColoriSalid |, . Iﬂ Ellue:lﬂ

QK I Cancel | Add to Custom Colors |

BNl HEEEENT
__HEE HEEET

Once you click OK in the Collision Object dialog, and if all required data is correctly
entered, a square will be placed on the layout. If there are errors, a message will
appear explaining the issue.

To edit a Collision Avoidance Object, left-click on it to reopen the dialog.

3.8.3 Setting Up a Collision Avoidance Object for your Control Panel

To configure a Collision Avoidance Object for your layout, enter Control Setup
Mode. Left-click on the Collision Avoidance Object image on the layout. The dialog
that appears depends on the avoidance type and is discussed below.

3.8.3.1 Turnout Collision Avoidance Control Panel Setup The dialog that
appears for Turnout Collision Avoidance is as follows:
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Dialog

Turnout Collision Avoidance Collision Object # 1

Proximity Locators

Blodk Number

Turnout

Locator #

Block # i}
Turnout # 0

{* Main Turnout Line
" Side Turnout Line

Automatic Restoration

Allow Automatic restoration
after problem correction

Start Locator Dedision Locator

1]
Note: Select the turnout line
that will not cause a

derailment.

Turnout
™ Use Second Turnout

OK Cancel

The dialog for Turnout Collision Avoidance requires the following inputs:

Start Proximity Locator Number: The first locator encountered when
approaching the turnout. It initiates the train direction testing sequence.

Decision Proximity Locator Number: The locator nearest the turnout,
acting as the decision point for determining turnout position to prevent
derailments.

Block Number: The control block number where power will be cut if a
derailment is detected.

Turnout #: The turnout being tested. You must specify whether it should be
in the "mainline" or "siding" position to avoid derailment.

Automatic Restoration: Enabling this option allows power to be restored
after a set delay (typically 4-6 seconds), accounting for the turnout switch

Automatic Restoration

Allow Automatic restoration
after problem correction

Delay after restoration

o Seconds
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time. The delay must be an integer (in seconds). Even with automatic
restoration enabled, manual control can be taken after the train has
stopped.

o Use Second Turnout: If you the Use Second Turnout box, the dialog changes
as follows:

Turnout
[+ e Second Turnout

Turnout # | ]

{* Main Turnout Line

(" Side Turnout Line

This feature allows you to address the third scenario described in section 3.8.1.1
where a turnout is directly in front of a second turnout as pictured below.

Second Turnout

' Decision Locator Start Locator
e O O N o ®

s

Turnout being tested
for Collision Avoidance

Using this dialog, enter the turnout number of the second turnout and the
direction that will not reach the turnout being tested for collision avoidance.

After entering all required data, click OK. If data is incorrect, an error message will
explain the issue.
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3.8.3.2 Track Occupied Collision Avoidance Control Panel Setup The dialog that
appears for Track Occupied Collision Avoidance is as follows:

Dialog X
Track Occupied Collision Avoidance Collision Object # 1
Proximity Locators Block Number gEnanL
Eraes IU— [ Use Turnout
1
Automatic Restoration
Locator #
Allow Automatic restoration
Start Locator a Decision Locator [i] r after problem correction
Train Collision Locators
OK Cancel

For Track Occupied Collision Avoidance, enter the following:

o Start Proximity Locator Number: The locator encountered first when
approaching an occupied block. It initiates train direction testing.

« Decision Proximity Locator Number: The locator closest to the potentially
occupied block. It determines train direction and when to check proximity
locators defined as Train Collision Locators.

« Number of Proximity Locators: Set the number of locators to be tested (1-
20). These do not include the start and decision locators. When a number is
selected the dialog box changes allowing the entry of those numbers as
shown below:
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Proximity Locators

10
Locator #

Start Locator i) Dedision Locator 0

Train Collision Locators

ol E 0
0 o
0 o
0 o
0 o

These are the locators that will be tested to determine occupancy.

o Block Number: The control block number where power will be cut if a
collision is detected.

» Automatic Restoration: Enabling this option allows power to be restored
after a set delay (typically 4-6 seconds), accounting for the turnout switch

Automatic Restoration

Allow Automatic restoration
after problem correction

Delay after restoration

0 Seconds

time. The delay must be an integer (in seconds). Even with automatic
restoration enabled, manual control can be taken after the train has
stopped.
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o Turnout: If selected, the dialog changes as follows:

Turnout

[+ Use Turnout

Turnout = 0

{* Main Turnout Line

" Side Turnout Line

This feature allows you to address the second scenario described in section 3.8.1.2
where a turnout is directly in front of a track block to be tested for track
occupancy as pictured below:

® [ — o @
f f o o
Start Locator Decision Locator

In this scenario the turnout position will determine whether the green or blue
block is important for occupancy. You should select either the main or side
turnout line. To provide a test for both the green and blue blocks you would need
to define 2 track occupied collision objects one for each track. We will clarify this
using the example above. The train occupied collision avoidance object testing the
green line should have the main turnout line set. When the train reached the
decision point since the turnout is pointed to the side turnout track, even if the
green or mainline is occupied, the power would not be cut.

Once all required data is entered, click OK. If errors exist, an error message will
provide details.

3.8.4 Control Panel Operation for a Turnout

Before using the collision avoidance feature, ensure individual objects are turned
on by clicking their symbols with the left mouse button. The color settings help
differentiate between active and inactive states.

When a collision avoidance event occurs:

Power is cut to the designated block.
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The block symbol starts flashing.

P

m.ﬁr zion

COLLISION

AVOIDANCE

If automatic restoration is enabled, operation resumes once the issue is cleared.
Otherwise, use manual restoration:

1. Correct the cause (e.g., adjust turnout position, reverse train direction,
etc.).

2. Close the collision avoidance warning window by right-clicking on the "X."
3. Restore power via the Block Control feature (refer to section 3.1.4).
If the issue is not resolved, the collision avoidance event will recur.

Multiple collision avoidance events can happen simultaneously. Since power is cut
only to one block at a time, the rest of the layout remains operational.

3.8.5 Practical Example

Due to the complexity of the collision avoidance feature, no simple test example is
provided. It is recommended that you familiarize yourself with Proximity Locators
and Track Block Controls before implementing this feature in your layout.
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3.9 Adding DCC Event or Sequence

A DCC Event or Sequence is an object that triggers one or more functions when a
locomotive passes over it. These functions could include sounding the horn,
executing a horn sequence (e.g., when approaching a crossing), changing speed,
stopping, and more.

To use this feature, both Grandpa’s Railroad Control Panel and Grandpa’s Railroad
DCC Throttle must be running.

3.9.1 Hardware Required
The layout must contain an RFID reader (see Section 3.13) and one or two
proximity locator’s setup as a connectivity network (see Section 3.6).

3.9.2 Adding a DCC Event or Sequence Object to your Layout
From the main menu select

m Grandpa's Railroad
File View Definelayout Help

Define Layout Size and Type

Shift Layout

Define Custom Turnout

Define RFID Tags

Add Track Segment >

Add Other Component ¥ Add Border Line

Add Button
Add Proximity Locator

Add Proximity Locator Activated Object ¥ Gate, Signal, or Animation

Add External Input Object > Collision Avoidance

Add RFID Reader DCC Event or Sequence _
Add WIFI Module

Add Legend

Define Layout/Add Other Component/Add Proximity Locator Activated Object/DCC Event or
Sequence

Upon selecting this menu item, the following dialog will appear.
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DCC Proximity Object Dialog *

Proximity Object Mumber I 0

—Object Location Center Point ——

Colors

Horizontal in inches Button Off | -
o oo | [

Vertical in inches

ICI.CIDCI

0K Cancel |

This dialog allows you to enter the Proximity Object number, position, and
ON/OFF colors of the object. Proximity Object Number: A unique number
(between 1 and 999) assigned to this object.

« Object Location Position: Defines the center of the circular indicator that
will appear on the layout.

« ON/OFF Colors: Customize the appearance of the button when activated or
deactivated.

Clicking either ON or OFF will open a color selection dialog.

*
ii
Hue:lﬁ Hed:lﬂ—
Sat: Iﬂ_ Green:lﬂ_

Define Custom Colors = | ColoriSolid | . ID Blue: ID

0K I Cancel | Add to Custom Colors |
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Using this dialog, you can select the color of the object.

Once you click OK and all required data is entered correctly, a circle will appear on
the layout. If there are errors, a message will detail what needs to be corrected.

To edit a DCC Event or Sequence Object, left-click on the object to reopen the
dialog.

3.9.3 Setting Up a DCC Event or Sequence Object

To configure a DCC Event or Sequence Object for your layout you must be in
Control Setup mode. Using the Left Mouse Button, click the DCC Event or
Sequence Object image on the layout and the following dialog will appear.

DCC Event or Sequence Dialog

Proximity Locators

¥ Directional [ Use Turnout

Locator #

Start Locator

0 Decision Locator 0

Function

Time

—

Type
* ON

Bell
Front light
Rear linkt

" OFF

Add

Delete

Edit

i

OK

Cancel
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Configuring Activation Conditions

The first step in configuring an event is determining how it will be triggered. If the
event should activate regardless of the train’s direction, only a Proximity Locator
Number needs to be entered. However, if the event should only activate when a

Proximity Locators

| Directional

Locator #

Activation 0

train is traveling in a specific direction, the Directional checkbox must be selected.
Enabling this option adds a second locator field, requiring activation in a

Proximity Locators

Iv Directional [ Use Turnout

Locator #

Start Locator W] Dedsion Locator 1]

predefined order: the Start Locator must be triggered before the Decision Locator
for the event to occur.

Both proximity locators must be integrated into a connectivity network that is
linked to an RFID reader. This ensures that the event is only triggered when a
specific, identified locomotive passes over the designated area.

Using Turnouts to Refine Activation

For more precise control, a turnout can be included in the activation conditions. If
the event should only occur when a train turns onto a siding, the Use Turnout

(O — 2R
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option should be selected. In this case, the system will only trigger the event if the
turnout is set to direct the train onto the designated track.

Proximity Locators
I+ Directional Iv Use Turnout ™ Use Second Turnout

Turnout #

Locator # . i
{* Main Turnout Line

Start Locator o Dedsion Locator |0 " Side Turnout Line

For more complex routing scenarios, such as requiring the train to pass multiple
turnouts before activation, the Use Second Turnout option can also be enabled.
This ensures that the event does not activate if the train diverts onto an earlier
track.

For the example above we would enter the data as shown below for the event or
sequence to only work when the train was entering the siding.

Proximity Locators
[+ Directional [+ Use Turnout [ Use Second Turnout

Turnout # 1

Locator # i .
(" Main Turnout Line

Start Locator 1 Dedision Locator | 2] {+ Side Turnout Line

In some cases, you may want the event to occur before two turnouts are reached.

If we have the case illustrated below and we only want to do the DCC event or
sequence when we are turning onto the second siding, then we would select Use
Turnout and Use Second Turnout.

o - (0 ()

For this example, we would not want the event or sequence to occur if we turned
on to the first siding. We would enter the data as shown below for the event or
sequence to only work when the train was entering the second siding.
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Proximity Locators

[+ Directional Iv Use Turnout ¥ Use Second Turnout

Turnout £ | 1] Turnout = |2

Locator #

{* Main Turnout Line " Main Turnout Line

Start Locato 1 Dedision Locatol 2
rtLoestor eeision Locator (" Side Turnout Line {* Side Turnout Line

Assigning Actions and Sequences

Once activation conditions have been set, the next step is defining the actions to
be performed when the event is triggered. The setup dialog provides a list where
users can assign specific functions to the event. Each action must include the
following parameters:

Time Delay: The delay (in seconds) after activation before the action occurs.
This value must be between 0 and 300 seconds.

Action Type: The specific function to be executed, selected from a
predefined list.

ON/OFF Status: Determines whether the action should turn the function
ON or OFF (for applicable actions).

Clicking Add will store the action in the sequence, allowing multiple actions to be
defined for a single event. A maximum of 30 actions can be assigned to a single
DCC sequence.

The available actions include standard locomotive controls, as well as
customizable options:

Horn

Bell

Front Light

Rear Light

Cab Light

Ditch Light

Speed

Custom 1-5 (user-defined functions based on DCC F Codes)
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The Custom values depend on the DCC F Code that you associate with them in the
DCC Throttle application.

In the above list Speed is a special function not requiring an ON/OFF entry.
Instead, if you select Speed, the following options appear.

—Function
Time Type

* . i
I Custom 4 * Stop Forward Backward
costem = ¢~ Same Direction " Reverse Direction

Add

Delete

Edit

i

If you then select any speed option other than Stop a_box will appear allowing you
to enter a % of full throttle or speed that you wish to change to.

—Function
Time Type % Speed

Custom 4 " Stop " Forward ¢ Backward I—
Custom 5 ) ] _ _ —
¥ Same Direction " Reverse Direction

Add

Delete

Edit

i

We have chosen to work with % of full throttle or speed as our approach so that
we can work with all makes of locomotives and decoders which achieving
approximately the same speed. (See the discussion of Throttle Limit in section
3.2.2 DCC Panel Setup of the DCC Throttle User’s Manual.)
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You can edit or delete a code by highlighting it in the list box (clicking it with the
left mouse button) and then pressing the Edit or Delete button.

A sample of how this dialog would appear if we wished to have the speed change
to 25% full throttle and a 1 sec horn blow at the same time follows:

Function

Time Type
’7 oM * OFF
Bell
Front light
Pear linkt
DT =0.000 : Speed : SAME DIRECTIOM : SPEED =25 Add

DT =0.000 : Horm @ ON
OT =1.000 : Horm : OFF
Delete

Edit

d

The actual rate of speed change depends on the momentum profile of your
decoder or whether you have Grandpa’s Railroad momentum activated.

3.9.4 DCC Event or Sequence Operation

Once configured, a DCC Event or Sequence is activated when a properly identified
locomotive passes over the designated proximity locator(s). A locomotive is
considered identified when it has been recognized by an RFID reader, which then
communicates the locomotive’s information through the connectivity network.

Upon activation, the corresponding control panel button will visually change from
its OFF color to its ON color, signaling that the event has been triggered. At the
same time, the programmed DCC functions will execute automatically, performing
the assigned actions in the specified order and timing.
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This feature allows for a highly automated and dynamic model railroad
experience, enabling locomotives to respond to layout conditions in a realistic and
controlled manner.

Make sure the DCC Throttle is operating, a DCC Panel has been
defined for the decoder address, and that you have defined the

F code for the function you are activating.

3.10 Adding Digital Input for Control Panel

The External Input Object: Digital Input for Control Panel allows a physical
external switch or button to interact with Grandpa’s Railroad Control Panel. One
of its primary uses is enabling an observer (such as a grandchild) to trigger a
feature or animation.

3.10.1 Hardware Required

To use a digital input, you will need at least one input connection on an
Input/Output Card or a Turnout Control & 1/0O Board.

A simple schematic illustrating how to connect a switch to the input connector is

shown below:

L]

synduj “
EEER

Outputs

Input / Output Card

For more information on electricity, voltage, and current, watch the Educational
Tutorials “Electricity 99”.
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3.10.2 Adding a Digital Input for Control Panel to your Layout
To add a digital input to your layout, you must be in Layout Setup Mode. From the
main menu, navigate to:

1] Grandpa's Railroad
File WView DefineLayout Help

Define Layout Size and Type

Shift Layout

Define Custom Turnout

Define RFID Tags

Add Track Segment »

Add Other Component » Add Border Line
Add Button
Add Proximity Locator
Add Proximity Locator Activated Object »
Add External Input Object » Digital Input for Control Panel _
Add RFID Reader Digital Input for DCC Panel
Add WIFI Module Speed Input for DCC Panel
Add Legend

Define Layout/Add Other Component/Add External Input Object/Digital Input
for Control Panel

Upon selecting this option, the following dialog box will appear:

External Input Dialog >

External Input Mumber 0

Object Location Position Colors

oo |
Horizontal in inches
0.000 Button On | _

Vertical in inches

0.000

Ok Cancel ‘
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This dialog allows you to configure the External Object Number, Position, and
ON/OFF colors of the object:

« External Object Number: A unique number between 1 and 999 assigned to
this object.

« Object Location Position: Specifies the center of the square indicator on the
layout.

o Colors: Customizes the ON and OFF colors of the button. Clicking either
button opens a color selection dialog:

Color X
R R &
RN NENN
FEEEEEN
EEEEEN
EEEEENR
L B 0 el e
Custom colors
EEEEEEEN w———
.llllllll e ot

C'efine Cuztam Colars =3 ColoriSalid |, .. ID Blue: ID

QK I Cancel | Add to Custom Caolors | |

Using this dialog, you can select the color of the object.

After entering all the required data, selecting OK will place a square indicator on
the layout, labeled "EX" followed by the object number.
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If any required information is missing or incorrect, an error message will appear
explaining the issue.

To edit an External Input Object, simply left-click on it, and the configuration
dialog will reappear.

3.10.3 Setting Up a Digital Input for your Control Panel

To configure a Digital Input for your layout, you must first enter Control Setup
Mode. Begin by clicking on the Digital Input for Control Panel image in the layout
using the left mouse button. This action will bring up a configuration dialog where
you can define the necessary settings for the input.

External Digital Input for Control Panel Dialog et

External Input Pin External Input Output

Mumber of Pins
WIFIModule  [1 L
WIFI Module PFin #
Input Pin # 0

External Input Shared Use Characteristics

rv Activate Pin even if other pin
users indicate off

Activate Pin only if a shared
user indicates OM

QK Cancel
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In this dialog, enter the Digital/Proximity WiFi Module number that corresponds
to the Input/Output Card or Turnout Control & 1/0 Board to which the input is
connected. This number is the actual value programmed into the WiFi Module.

Note: You must use the WIFI Module Programmer software to

program that number and your router name and password into
each module.

The Pin # is calculated based on the connector where the ribbon cable is attached
to the WiFi Module and the connector number on the Input/Output Card or

Turnout Control & 1/0 Board. For example, if the WiFi Module contributes 13 and
the board contributes 2, the total Pin # is 15, which should be entered in the field.

N

o2 5 T ®
«
r : y Dok

pieog 0/ ® 1043u0) ino

Once the Pin # has been set, determine how many Output Pins this external input
will activate. A value of zero means the external input is disconnected, while up to
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eight pins can be activated with a single button. If a non-zero value is selected, the
dialog updates, allowing you to specify the Output Pin to be controlled.

External Input Dialog et
External Input Input Fin External Input Output
Mumber of Pins 2
WIFI Module 1 -
WIFI Module Pin #

Input Pin # 15|

E N

External Input Shared Use Characteristics

¢ Activate Pin even if other pin
users indicate off

Activate Pin only if a shared
user indicates OM

QK. Cancel

For each Output Pin activated, you must enter the Digital/Proximity WiFi Module
number connected to the 1/O card. This value must match the programmed
module number.

The final setting to configure is whether the external input is shared. Sharing
allows the external input to be paired with a button or Proximity Objects,
providing flexibility in how the input interacts with the control panel. For example,
if an external input enables visitors to control an animation, sharing it with a
button lets you disable or redirect it to another pin.

There are two types of button sharing:
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1. The button always activates the designated pin, even if other users have
set it to Off.

2. The button only activates the designated pin if both the external input and
other users have set it to On.

For example, if an external input is set to type 2 sharing and controls two different
pins, each with an associated button, Pin 1 and its animation will only turn On if

Button 1 External Input Button 2

|Pin1| Ipin1| |Pin2| |Pin2|
both Button 1 and the external input are On. The same applies to Pin 2, which
will activate only if both Button 2 and the external input are On. This setup allows
real-time control of the external input’s effects without modifying the Control
Panel Setup.

3.10.4 Digital Input for Control Panel Operation

The Digital Input for Control Panel is activated by pressing an external button or
switch. When activated, the control panel color changes from the OFF color to the
ON color, providing a clear visual indication of activation. Additionally, the
associated pins are triggered, allowing the connected devices or animations to
respond accordingly.

3.10.5 Practical Example

To demonstrate how a Digital Input works, we will use a multimeter to observe
how the output connection changes when the external button is pressed. When
the button is Off, the switch remains open, meaning resistance is unmeasurably
high. When the button is pressed, the switch closes, and the resistance drops to a
very low value. We will also connect a simple LED circuit to confirm the activation
by lighting up an LED.

Step 1:

Start the Grandpa’s Railroad Application, select Layout Setup Mode, and create a
10-inch by 10-inch layout in any scale. (Note: A layout does not need to contain
track. In this example, we are only adding a button.)
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Step 2:

Add a WiFi Module to the layout at 2 inches Horizontal and 5 inches Vertical,
configuring the Connected and Not Connected colors.

WIFI Module Dialog x

WIFI Module Mumber

1

Object Location Center Point

Horizontal in inches Colors

2.000 WIFI Mot Connected _

Vertical in inches WIFI Connected
5.000

oK Cancel ‘

Step 3:

Add an External Input to the layout at 8 inches Horizontal and 5 inches Vertical.
External Input Dialog *

External Input Mumber 1
Object Location Position Colors

Horizontal in inches

Vertical in inches

5.000

Edit Data Delete Cancel
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Step 4:

Connect the hardware as shown below:

RANGE RELA Hz &

+6
*b guuixoid

o+ Digital jio

.‘ L
on [ByiByq +§

F WIFI Nt
Controller 5 | e

rosieeein

o Power the WiFi Module.
Connect the Input/Output Card to the 13+ port on the WiFi Module.

Wire the external switch to the +2 connector on the input side of the
board.

Attach a multimeter to the +3 connector on the output side.

These connections assign Pin #15 to the switch and Pin #16 to the multimeter. The
Turnout Control & 1/0 Board from the basic system is used for this setup.
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Step 5:
From the File Menu, navigate to:

fi Grandpa's Railroad
File View Define Layout Help

Open Layout
Save Layout

Save Layout As
Prograrm Mode * Control Panel
Exit Control Panel Setup _

Layout Setup

File/Program Mode/Control Panel Setup
This switches the system to Control Panel Setup Mode.
Step 6:

Move the cursor over the External Input and click the left mouse button to open
the configuration dialog.

o Based on our connections, enter 1 as the Module #.
o Enter 15 as the Pin # for the input switch.
o Enter 16 as the Pin # for the output connection.

« Since there are no other defined external inputs or buttons, the sharing
type is not applicable here.
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External Digital Input for Control Panel Dialog

External Input Pin External Input Output

0
Mumber of Pins
WIFIModule [ 1 ;

WIFI Module Pin #
Input Pin # 15
1 16|

External Input Shared Use Characteristics

fv Activate Pin even if other pin
users indicate off

~ Activate Pin only if a shared
user indicates OMN

OK Cancel

Step 7:
Go to the Control Panel Mode by selecting:

i Grandpa's Railroad
File VWiew Definelayout Help
Open Layout

Save Layout

Save Layout As
Program Mode ¥ Control Panel _
Exit Control Panel Setup

Layout Setup

File/Program Mode/Control Panel
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Step 8:

Once the Digital/Proximity WiFi Module is connected, the screen should reflect
the setup.

M 1

At this point, the multimeter should display 0.L, indicating an open circuit (no
connection).
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When you press the External Input switch, the screen updates, and the

M 1

multimeter reading changes to 0.4 ohms, signifying a closed circuit. Additionally,
a red LED near the connector lights up, confirming the switch is active.

For those following the "Electricity 99" Educational Tutorials, this setup can be
expanded for practical model train applications. Instead of a multimeter, a Digital
Input for Control Panel can be used to control layout lighting or trigger
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animations. In a real-world setup, the battery pack used in this example would be
replaced with a dedicated accessory power source for consistent operation

This example highlights how a Digital Input for Control Panel can be used for

interactive model train layouts, allowing users to automate animations, lighting,
and other electrical components with ease.
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3.11 Adding Digital Input for DCC Panel

If you are using Grandpa’s Railroad Control Panel along with Grandpa’s Railroad
DCC Throttle, you can control certain locomotive functions using an external
input. For example, visitors can blow a locomotive horn or ring a bell using a
physical switch or button.

3.11.1 Hardware Required
To set up a digital input, you will need at least one input connection on either an

Input/Output (1/0O) Card or a Turnout Control & I/O Board.

A simple schematic showing how to connect a switch to the input connector is

provided below:

L]

synduj “
EEER

Outputs

Input / Output Card

For a deeper understanding of electricity, voltage, and current, refer to the
educational tutorial “Electricity 99.”

3.11.2 Adding a Digital Input for DCC Panel to your Layout
To add a Digital Input for DCC Panel to your layout you must be in the Layout
Setup mode. From the main menu select
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1] Grandpa's Railroad
File View DefineLayout Help

Define Layout Size and Type

Shift Layout

Define Custom Turnout

Define RFID Tags

Add Track Segment »

Add Other Component » Add Border Line
Add Button
Add Proximity Locator
Add Proximity Locator Activated Object »
Add External Input Object » Digital Input for Control Panel
Add RFID Reader Digital Input for DCC Panel
Add WIFI Module Speed Input for DCC Panel
Add Legend

Define Layout/Add Other Component/Add External Input Object/Digital Input
for DCC Panel

Upon selecting this menu item, the following dialog will appear.

External Input Dialog >
External Input Mumber 0
Object Location Position Colors

oo | |
Horizontal in inches
0.000 Button On | _

Vertical in inches

0.000

Ok Cancel ‘

In this dialog, you can enter:

« External Object Number (a uniqgue number between 1 and 999).
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« Object Location Position (the center position of the square indicator on the

layout).

« ON/OFF Colors (to customize the button’s appearance).

Selecting a color will open another dialog where you can choose the desired color

for the object.
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Custom colors:

Define Cugtomn Colars = |

Cox |

Cancel |

- Hue:lﬁ

ColorSalid Lum: ID_

X
i(

Red:[0

Sat:lﬂ_ Green:lﬂ_

Blue: Iﬂ_

Add to Custom Colors |

Using this dialog, you can select the color of the object.

Once all required information is entered and confirmed, a square labeled "DCCD"

+ object number will appear on the layout.

If there are any errors, a detailed message will explain what needs to be

corrected.

To edit an External Input, left-click the object in the layout, and the configuration

dialog will reappear.
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3.11.3 Setting Up a Digital Input for your DCC Panel

Once a digital input has been added to the layout, it must be configured to
function properly within the control system. To do this, you need to enter Control
Setup Mode and click on the Digital Input for DCC image within the layout using
the left mouse button. This action will open a configuration dialog where you can
enter the relevant settings.

Dizlog X

External DCC Input Fin Locomotive Address

WIFI Module |1
Ok Cancel
) Address 0
InputPin# |0

Button Down F Codes
Type )
Time Add Delete Edit
Horn
Bell
Front light + on " Off
Bear linht
Button Up F Codes
Type Add Delete Edit
= Horn
Bell
Front light " on v Off
Bear linht
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The first required setting is the Digital/Proximity WiFi Module Number, which
corresponds to the WiFi module that is physically connected to the Input/Output
Card or Turnout Control & I/0O Board. This number must match the one

programmed into the module.

Note: You must use the WIFI Module Programmer software to
program that number and your router name and password into

each module.

Next, you need to determine the Pin Number for the connection. The pin number
is calculated by adding two values: the number of the connector on the
Digital/Proximity WiFi Module where the ribbon cable is attached and the
connector number on the Input/Output Card or Turnout Control & |I/0O Board. For
example, if the module’s connector is numbered 13 and the board’s connector is

ez R,

S
9+ Digital o

PieOg 0/| ® 103u0) }no

numbered 2, then the total pin number will be 15. This value must be entered
correctly to ensure the input device functions as expected.
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The Locomotive Address field allows you to specify the DCC address of the
locomotive that will be controlled by this external input. Before assigning an
address, make sure that a locomotive panel has already been set up in the DCC
Throttle application for the corresponding locomotive. This ensures that the input
is properly linked to the intended train.

The dialog also includes a section for defining what actions will occur when the
button is either pressed or released. Two list boxes on the left side of the dialog
allow you to create a sequence of events based on input activation. To configure
an action, you must enter a time delay (in seconds) that determines when the
event should take place after the button is pressed or released. The time delay
must be between 0 and 300 seconds. After entering the time, you can select an
action type from a predefined list of commands. These include the following
functions:

e Horn

« Bell

o Front Light
o Rear Light

« Cab Light

« Ditch Light

e Custom 1 - Custom 5 (Configurable via DCC Throttle F Codes)

The Custom values allow users to associate unique DCC F Codes with the external
input. These codes can be configured in the DCC Throttle application to perform
specialized functions.

Note: You must setup the F Codes for the above functions in the

DCC Throttle. (see Section 3.1.2 of the DCC Throttle User’s Manual)

Once an action has been defined, you must specify whether it should be triggered
when the button is in the ON or OFF state. After making a selection, press the Add
button to store the action. Each button sequence can accommodate up to 30
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different actions. If you need to modify or remove an existing action, simply click
on the item in the list and press the Edit or Delete button.

For example, if you want the external button to activate the locomotive’s horn
while it is being pressed, you would select the Horn action and assign it to the ON
state. This means that as long as the button is held down, the horn will sound, and
it will stop when the button is released.

Button Down F Codes
Type i
Time Add Delete Edit
Harn
Bell
Front light * On " off
Rear linkt
OT =0,000 : Horm : ON
Button Up F Codes
Type Add Delete Edit
Time Harn
Bell
Front light " on v Off
Bear linht
OT =0.000 : Horn : OFF

3.11.4 Digital Input for DCC Panel Operation

Once the digital input has been configured, it becomes fully functional within the
system. When an external button or switch is pressed, the input is activated,
causing the corresponding color on the control panel to change from the OFF
color to the ON color. This visual feedback helps operators verify that the input
has been successfully triggered. At the same time, the assigned DCC function—
such as sounding the horn, ringing the bell, or turning on a specific light—will be
executed by the locomotive.
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This functionality adds a dynamic, interactive element to your model railroad,
allowing visitors or operators to engage with the system in a tactile way. Whether
it's for demonstrations, automation, or simply enhancing the realism of your
layout, digital inputs provide a powerful way to extend the capabilities of
Grandpa’s Railroad Control Panel.

Make sure the DCC Throttle is operating, a DCC Panel has been
defined for the decoder address, and that you have defined the

F code for the function you are activating.

3.12 Adding Analog (Speed) Input for DCC Panel

If you are using Grandpa’s Railroad Control Panel in conjunction with Grandpa’s
Railroad DCC Throttle, you can control the speed of a locomotive externally using
the Analog (Speed) Input for the DCC Panel object. This feature is particularly
useful for installing an external throttle, allowing children to control a train safely.
Since Grandpa’s Railroad enables maximum throttle position control and collision
avoidance, it ensures a secure experience even for younger users.

Additionally, external control of a locomotive's horn, bell, and/or lights can be
managed using the Digital Input for the DCC Panel, making it possible to set up a
complete external control panel for a locomotive.

3.12.1 Hardware Required
The following hardware components are needed:
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50K ohm Potentiometer:

RFID WIFI Module:

The potentiometer should be wired to the connector provided with your RFID
module as shown below. We recommend using solid-wire phone cord and cutting
the green wire.
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3.11.2 Adding a Analog (Speed) Input for DCC Panel to your Layout
To add a Analog (Speed) Input for DCC Panel to your layout you must be in the
Layout Setup mode. From the main menu select

1] Grandpa's Railroad
File WView DefineLayout Help

Define Layout Size and Type

Shift Layout

Define Custom Turnout

Define RFID Tags

Add Track Segment »

Add Other Component » Add Border Line
Add Button
Add Proximity Locator
Add Proximity Locator Activated Object »
Add External Input Object » Digital Input for Control Panel
Add RFID Reader Digital Input for DCC Panel
Add WIFI Module Speed Input for DCC Panel _
Add Legend

Define Layout/Add Other Component/Add External Input Object/Speed Input
for DCC Panel

Upon selecting this menu item, the following dialog will appear.

External Input Dialog X

External Input Mumber o

Object Location Position Colors

swencr | [
Horizontal in inches
oo sunon | |

Vertical in inches

0,000

Ok Cancel ‘
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This dialog allows you to configure the External Object Number, Position, and
ON/OFF colors of the object:

« External Object Number: A unique number between 1 and 999 assigned to
this object.

» Object Location Position: The center location of the square indicator that
will be placed on the layout.

o Colors Group: Used to customize the ON and OFF colors of the object.
Clicking either button opens a color selection dialog.

Color bl
Basic colors:
S e § B
HMrTEFENEN
ENEEEEEN
EfNEEEEEN
AN EEEEENR
AEEEETET
Custom colars:
4
HHHH o
Sat:lﬂ— Green:lﬂ—
Define Custom Colors > | ColoriSolid Lum:lﬂ— ENue:ID—
oK I Cancel | Add to Custom Colors |

Using this dialog, you can select the color of the object.

Once you select OK from the External Input dialog and if you have entered all
required data, a square will be placed on the layout. The Label will be DCCA plus
the object number.

If the data has not been added correctly, a detailed error message will appear
explaining what is incorrect.
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If you need to edit an External Input, you can left click with your mouse on the
External Input Object and this dialog will reappear.

3.12.3 Setting Up a Analog (Speed) Input for your DCC Panel

To set up a Analog (Speed) Input for your layout you must be in Control Setup
mode. Using the Left Mouse Button, click the Analog (Speed) Input image on the
layout and the following dialog will appear.

External DCC Analog Input Dialog X

External DCC Input Fin Locomotive Address

WIFI Module |1

Add lﬂi QK Cancel
ress
InputPin % |0

You must enter the RFID WIFI Module number that the Potentiometer connector
is connected to. That number is the actual number that is programmed into the
WIFI Module.

Note: You must use the WIFI Module Programmer software to

program that number and your router name and password into
each module.

The Input Pin # is the number on the RFID WIFI Module next to the connector
that you plug the potentiometer into.

The Locomotive Address is the DCC address for the locomotive you wish to have
the Analog (Speed) Input control. A locomotive panel for this address must be
setup in the DCC Throttle application.
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3.12.4 Analog (Speed) Input for DCC Panel Operation

The Analog (Speed) Input is activated by rotating the potentiometer knob. The
input follows all the same rules as the thumb button on the throttle of a
locomotive panel. If the potentiometer appears to not be working, check if the
thumb knob is working. If not make the corrections (direction selected,
locomotive power on, etc.) to make it work and then try the potentiometer again.

3.13 Adding RFID Reader

RFID is an acronym the stands for “Radio Frequency Identification”. It is a
wireless method of identifying an object and in some cases transmitting data.

The RFID system is be composed of two parts. A two-way radio
transmitter/receiver called an Interrogator or Reader, and a transponder called a

Tag. There are two types of tags, active and passive. Active tags have their own
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power source while passive tags get their power from the reader. At Grandpa’s
Railroad we only use the passive tags since they are cheaper and simpler to install.

The RFID Tag consists of a micro-chip and a coil antenna. For a passive tag, a coil
antenna at the Reader produces a magnetic field which when the tag coil antenna
is in the vicinity produces an electrical current to power the micro-chip of the tag.
The antennas are also used for data transmission and reception. This method of
powering the tag is like the way wireless cell phone charging works.

When the reader interrogates a tag, it readers a unique identifier and in some
cases data from the non-volatile memory of the chip. Currently we read only the
identifier since we are storing no data on the tag.

3.13.1 Hardware Required
The following hardware is used:

RFID Reader:
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RFID Tag:

RFID WIFI Module:

} Bojeuy

2 Analog  RFID 2

=8
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3.13.1.1 Wiring the RFID Reader

The connector for the RFID reader on the RFID WIFI Module is a RJ12 type,
6-position, 6-conductor (6P6C). Therefore, we use an RJ12 cable to wire it. The
simplest way to get this cable is to buy a RJ12 cable with a connector on each end
and cut off the connector with the length of wire you need. If you have a crimp

tool like the one shown you can make additional connectors from any excess
cable.

7654321|654321

The maximum length of a RFID cable is 3 to 4 feet. Longer than
this may cause erratic behavior.

To connect the cable to the RFID Reader you can solder it directly to the card or
use the 6 pin connector provided with the card. We prefer this method since we
feel it provides a stronger connection which is easier to mount. Whichever

method you choose the card should be wired and the switches positioned as
follows:
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Blue

Yellow
1 MOS) (= Green
I ss (& Red
I Black
White

Note: The two switches in the upper left corner of this image
must be positioned as shown. The card does not come pre-
configured in this arrangement. The switch on the left should be
placed toward the center of the card, while the switch on the
right should be positioned toward the outer edge.

If you choose to use the connector do the following:

Step 1: Solder the six-pin header to the topside of the RFID reader from the SCK
to GND positions. We put the header on the top side so that when mounted, the




RFID reader will be upside down. Therefore, ballast will not be placed directly on
the card components.

Step 2: Cut the desired length of RJ12 cable. Strip about 1 % inches of the cable
shield. Strip about 3/8 inch of insulator from each colored wire and twist the
copper strands to form a single wire.

Step 3: Using fine point pliers crimp a female pin connector to each wire.

e The pointed tabs should be used over the insulated part of the wire.

e The rectangular tabs should be used over the bare wire.

e Crimp each wire hard so that the wire will not slide out.

e Make sure you have kept each crimp as small as possible

e Give each wire a small tug to make sure it is secure.

e Keep the pins as straight as possible since you will need to slide them inside
of the plastic housing.
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Step 4: Slide the female pin connectors inside the plastic housing. The small
bump at the top of the pin should face the hole in the housing and will snap into it

when properly seated.
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The finished connector should look like this.

Step 4: Slide the connector on the six pin header on the RFID Reader making sure
the blue wire is on the SCK pin and white on the GND pin.

3.13.1.2 Mounting the RFID Reader

The RFID Reader must be centered under the track as close as possible to the
track. On Grandpa’s Railroad we use cork roadbed on % inch plywood as the base
for the track. For this setup it is easy to mount the RFID reader card.

Important: Since this item is not easy to replace it should be

tested often during installation. This can be done similar to the
method shown under a 3.13.5 Practical Example.

Step 1: Cut out a section of cork roadbed the size of the reader.
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Step 2: Cut a slot in the plywood at the location of the connector. If you have
soldered the cable to the reader, you can drill a hole that the RJ12 connector can
pass through. (Note the orientation of the reader is not important.)

Step 3: Pass the connector through the slot and slide it onto the pin header
making sure that the white wire is connected to GND. It is best at this point to test

the reader to make sure it is wired properly and working.
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Step 4: If the reader is working, glue it in place using a hot glue gun.

Step 5: Place the track over the reader and test it again.
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Step 6: You can ballast over the card and track as you normally as long as there is
no metal in the ballast. (Make sure the ballast is totally dry before powering up
the reader.)

3.13.1.3 Placing the RFID Tag on the Locomotive
The tags supplied with your RFID reader are self-stick. They should be applied:

e So, they travel between the tracks.
e So, they travel as close to the reader as possible.
e Do not apply to a metal surface.

e Do not place near the motor since the motor generates electrical waves
that can interfere with the Tag.
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We have found that on most HO scale locomotives the best place for the tag is
under the front trucks.

N scale locomotives do not have enough space for placement in this location. On
most of our locomotives, trimming the tag and mounting it on the fuel tank has
been successful,

even though it is near the motor. Placement is a trial-and-error process—position
the tag and test it by running the locomotive over an RFID reader to check
functionality.

If no suitable location is found on your locomotive, you can always mount the tag
on the first car following the locomotive.
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3.13.2 Adding a Reader to your Layout
To add a RFID Reader to your layout you must be in the Layout Setup mode. From
the main menu select

i Grandpa's Railroad
File View Definelayout Help

Define Layout Size and Type

Shift Layout
Define Custormn Turnout
Define RFID Tags
Add Track Segment ]
Add Other Component » Add Border Line
Add Button
Add Proximity Locator
Add Proximity Locator Activated Object »
Add External Input Object »

Add RFID Reader <4

Add WIFI Medule
Add Legend

Define Layout/Add Other Component/Add RFID Detector

Upon selecting this menu item, the following dialog will appear.

RFID Reader Display Dialog *

RFID Mumber

Colors
RFID Reader Display position
Background |
Horizontal 0,000
s |
Vertical 0.000
oK Cancel ‘ Delete ‘
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This dialog allows you to enter the RFID number, display position, and background
and border colors of the object display.

RFID Number is a number between 1 and 999 that you assign to this object. This
number must be unique for the object.

Reader Display Location Position is the location of the center of the rectangle
RFID display that will be placed on layout. We find it convenient to locate the
display near the actual reader so that we can associate the data with the reader.

The Colors group is used to customize the background and border color for the
RFID diaplay. Pushing either button will cause the following dialog to appear.

Color x

Basic colors:

N N N

I o .

NN N N

o n LN

HEE LN

. N

-. Hue1 Hedﬂ'
== .- -

Cefine Custom Colors »3 ColoriSalid |, . ID Blue: ID

QK I Cancel | Add to Custom Colors |

Using this dialog, you can select the color of the object.

Once you select OK from the RFID Reader Display dialog and if you have entered
all required data, a rectangle will be placed on the layout. If the data has not been
added correctly, a detailed error message will appear explaining what is incorrect.

If you need to edit an RFID Reader Input, you can left click with your mouse on the
RFID Reader Display and this dialog will reappear.
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3.13.3 Setting Up a RFID Reader for your Control Panel

To set up a RFID Reader for your layout you must be in Control Setup mode. Using
the Left Mouse Button, click the RFID Reader Display image on the layout and the
following dialog will appear.

RFID Control Dialog X

RFID Input Mearest Proximity Locators

RFID WIFT Module #1 li

Input #

QK Cancel

You must enter the RFID WIFI Module number and the input connector number
that the RFID reader is connected to.

The Nearest Proximity Locators group allows you to enter the number of the
nearest proximity locator on each side of the RFID Reader. This data is not
required and may be left blank. If it is left blank, then the reader will only show
the locomotive identification in the display box. While this doesn’t serve much
purpose it will indicate the reader is working. If you do enter these locators and
have done similarly with the proximity locators, the reader will be linked to a
connectivity network. This network will allow the train to be tracked as it passes
over other locators. Also, DCC Event or Sequence Objects can be defined and tied
to this network.

3.13.4 RFID Reader Control Panel Operation

During operation the RFID Reader display will display the Tag identifier or the
locomotive identifier for all locomotives that have an RFID Tag installed. /f you
have just installed a tag on a locomotive, you will not know it’s tag value.
Therefore, run the locomotive across an RDFI detector so that you can read the
tag. You can now assign a locomotive to that tag value. (See Section 2.4)
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If you have defined a proximity locator that is a nearest neighbor, a connectivity
network will be started for that locomotive, so that its train color can be displayed
on the proximity locators and DCC Event or Sequence objects activated.

3.13.5 Practical Example
As you build and install you RFID reader it is best to test it at various steps to verify
operability since replacement is difficult. The flowing steps can be used to test it.

Step 1: Wire the reader as specified in Section 3.13.1.1 Wiring the RFID Reader.

Step 2: Start the Grandpa’s Railroad Application, select the Layout Setup mode,
and create a 10-inch by 6-inch layout in any scale. (Note: A layout does not need
to contain track. In this example we are only adding a button.)

Step 3: Add a WIFI module to the layout at 5 inches Horizontal and 2 inches
Vertical with the desired Connected and Not Connected colors

WIFI Module Dialog et

WIFI Module Mumber

25

Object Location Center Point

Horizontal in inches Colors

=  —

Vertical in inches |

2.000

Edit Data Delete Cancel

The WIFI module we are using is number 25. This number corresponds to the
actual number programmed into our WIFI Module. You should use the number
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you programmed into your WIFI module with the WIFI Module Programmer
software.

Step 4: Add an RFID Detector to the layout at 5 inches Horizontal and 5 inches
Vertical.

| RFID Reader Display Dialog X

RFID Mumber 1

—Caolors
—RFID Reader Display position
Backaround |
Horizontal 5,000
| s |
Vertical I 5.000
K Cancel | Delete |
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Step 5: Connect the hardware as pictured below:

We have connected power to the WIFI Module and the RFID detector to the RFID
#1 on the WIFI Module.

Step 6: From the File Menu item select:

B Grandpz's Railroad
File View Define Layout Help

Open Layout

Save Layout

Save Layout As

Program Mode » Control Panel

Exit Control Panel Setup —

Layout Setup

File/Program Mode/Control Panel Setup

This will change to the Control Panel Setup mode.
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Step 7: Place the mouse cursor over the RFID reader and press the left mouse
button.

The following dialog will appear.

RFID Control Dialog et

RFID Input Mearest Proximity Locators

RFID WIFI Module | 25 =1 li
Input # lli =7 li

QK Cancel

Based on the connections we made in step 5, the RFID module # is 25 and the
Input # is 1.

Step 8: From the File Menu item select:

i Grandpa's Railroad
File View Definelayout Help
Open Layout

Save Layout

Save Layout As
Program Mode ] Control Panel _
Exit Control Panel Setup

Layout Setup

File/Program Mode/Control Panel

This will change to the Control Panel mode.
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Step 9: If you have used our setup parameters and colors, after the WIFI Module
connects, the screen should resemble the following.

Now hold an RFID tag in front of the RFID reader. (This is the bottom side of the
card.)
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The screen should now display the RFID tag number.

445265156

If you have previously associated the tag you are using with a locomotive as
defined in section 2.4 Defining RFID Tags, then the train label and the colors
associated with it will appear.

3.14 Adding WIFI Module

The WIFI Module is the basic controller for Grandpa’s Railroad Control
Panel. All other cards are connected to this controller. Up to 32 controllers can be
used on one layout.

There are two types of modules Digital/Proximity module and RFID/Analog
module. The first Digital/Proximity WIFI module can process up to 16 digital I/0
elements and 16 proximity locators. Since a turnout only requires one digital I/O
connection, this means that up to 512 turnouts and 512 proximity locators could
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be used on one control panel if only this type of module were used. The second
RFID/Analog module can process two RFID readers and two analog inputs. The
controllers pass information to the main centralized computer via WIFI for
processing. Each WIFI controller that is added must have a unique number from 1
to 32. Controllers must first be programmed to set the number, WIFI name, and
WIFI password for your system. This is easily accomplished by using the WIFI
Module Programmer App preloaded on the Windows PC. (See the WIFI Module
Programmer User’s Manual.)

189



3.14.1 Hardware Required

The following hardware is used:

Digital/Proximity WIFI Module

Proximity Connector
for pins 1-8

Proximity Connector
for pins 9-16

Digital I/0 Connector
for pins 5-8

Digital I/0O Connector
for pins 1-4

bl

+
’ o/l 1eybia -

** Kywxosg *8

Digital I/0 Connector
for pins 13-16

Digital I/0 Connector

WIFI for pins 9-12
Controller
|
{ . 5 Volts -
g @ | 5 \/olt Input

USB Port

Used only with WIFI Module Programmer
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RFID WIFI Module

Analog Input 2

RFID Reader 2

Analog Input 1

RFID Reader 1

USB Port
Used only with WIFI Module Programmer

191

5 Volt Input




5 Volt Power Supply or Buck Converter A 5-volt power supply or

buck converter

is needed for the WIFI module. Both are capable of powering 2 WIFI Modules. The
buck converter would also need a 7-to-20-volt DC power supply. We have
presented this latter option since on our layouts we only use one 12-volt power
supply to power everything, DCC command station, WIFI modules, lighting, sound,
etc. This simplifies power distribution and eliminates multiple power supplies
reducing costs.
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3.14.2 Adding a WIFI Module to your Layout

A WIFI Module is the remote data collector and controller of the Grandpa’s
Railroad system. You must add each module you use to identify it for identifying
connections in the Control Panel Setup mode. To add a WIFI Module of either
type to your layout, you must be in the Layout Setup mode. From the main menu
select

=2 Grandpa's Railroad

File View Define Layout Help

Define Layout Size and Type
Shift Layout
Define Custom Turnout
Define RFID Tags
Add Track Segment »
Add Other Component ] Add Border Line
Add Button
Add Proximity Locator
Add Proximity Locator Activated Object »
Add External Input Object »

Add RFID Reader

Add WIFI Module _

Add Legend

Define Layout/Add Other Component/Add WIFI Module
Upon selecting this menu item, the following dialog will appear.
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WIFI Module Dialog X

WIFI Module Mumber

]

Object Location Center Point

Horizontal in inches Colore

0.000 WIFI N-:utCDnnected| _
Vertical in inches WIFI Connected | _

0.000
QK Cancel

WIFI Module Number is the number from 1 to 32 that has been programmed into
the module. There must be only one module per layout using this number. If you
reprogram the module with a different number, you must edit this value.

Object Location Center Point is the point on your layout that the Module is
displayed. Typically, this should be at the location of the module or in the near
vicinity so it can be easily associated with the module. Its location is for display
only so you can place it anywhere.

Colors allow you to enter a unique color for the connected and not connected so
that problems connecting can be analyzed if they occur.

Once you select OK from the dialog and you have entered all required data, a
Rectangle will be placed on the layout with the appropriate color and the text M#
where # is the module number. If the data has not been added correctly, a
detailed error message will appear explaining what is incorrect.

If you need to edit the Module data, you can left click with your mouse on the
Module element while in Layout Setup Mode and this dialog will reappear.
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3.14.3 Setting Up a WIFI Module for your Control Panel
No setup is needed in Control Panel Setup. The Module number was specified in
the Layout Setup mode.

3.14.4 WIFI Module Control Panel Operation
When power is applied to a WIFI Module the top will light with a green, red
combination.

This indicates that the module has not yet connected to the WIFI network. In less
than 10 seconds the module light should turn totally green indicating a
connection.

If the Module does not connect, it could possibly be for one of the following
reasons:

195



1) The WIFI router network name is incorrect in the module.

2) The WIFI router network password is incorrect in the module.

3) The WIFI router is not On.

4) The WIFI router is too far from the module, therefore its signal is too
weak.

The power should be applied to the WIFI Modules in a layout at
least 10 sec before opening a file in the Control Panel Mode. This

allows time for the modules to connect to the network before the
Grandpa’s Railroad software tries to connect to them.

After the Modules are connected, and when you open a layout file in the Control
Panel mode, the Grandpa’s Railroad software will connect to the modules. If you
have selected different colors for the Connected and Not Connected states for the
modules, the color of the modules should change. After several seconds if all
modules in your layout file have not been connected, an error message will
appear. Possible reasons connection does not occur are:

1) The Grandpa’s Railroad Mini PC is not connected to the network.

2) The Mini PC and modules are connected to different networks. This can
occur if you have used your Mini PC on your home network and have
not changed it back to the Grandpa’s Railroad router network.

3.14.5 Practical Example
A simple example using a Digital/Proximity WIFI Module is to create a layout that
only contains the module.

Step 1: Start the Grandpa’s Railroad Application, select the Layout Setup
mode, and create a 10-inch by 10-inch layout in any scale. (Note: A layout does
not need to contain track. In this example we are only adding a WIFI Module.)

Step 2: Add a WIFI moule to the layout at 2 inches Horizontal and 5 inches
Vertical with the desired Connected and Not Connected colors.
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WIFI Module Dialog X

WIFI Module Mumber

1

Object Location Center Point

Horizontal in inches

Colors
2,000 WIFI Mot Connected | _
Vertical in inches WIFI Connected |

5.000

QK Cancel

Step 3: Connect power to the WIFI Module and make sure the module light
turns fully green indicating it has connected to the network.

Step 4: From the File Menu item select:

fi Grandpa's Railroad
File View Define Layout Help

Open Layout
Save Layout

Save Layout As
Prograrm Mode * Control Panel _
Exit Control Panel Setup

Layout Setup

File/Program Mode/Control Panel

This will change to the Control Panel mode.
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Step 5: If you have used our setup parameters and colors, after the WIFI
Module connects, the screen should resemble the following.

M 1

Step 6: To determine the strength of the connection, from the View Menu
item select:

i ChUsers\Grandpa\CneDrive\Grandpas Railroad\Layouts WIFRNWIFI Module Only.Trk
File Wiew Help

View/Print Functions » Turnout Connecticns »

Hide Proximity Locators » Button Connections »

Hide Proximity Objects Proximity Locator Connections »

Hide WIF| Servers When On Proximity Object Connections »

Hide Track Control Points Block Connections »

Hide Boundaries Cutput Pin Usage »

Show All Input Pin Usage »

Track Coler » WIFI Status _
Possible Problerns Checking »

Input Pin Values
Print All Setup P
Analog Pin Values nn up Fages
Block Color Assignments 5

Cab Color Choices

foom >
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View / View/Print Functions / WIFI Status

This will provide a window containing the status of all WIFI modules in the layout.

r'

m = || B ER

WIFI Status

WIFI Module # Module Ver Power UF LD
32 2.1 50 98 0

The most important number for users in this window is the Power number. This
number has units of dbm or decibel milliwatts. Basically, the smaller the number
the worse the signal strength. To make this perfectly clear since there can be some
confusion as to what smaller means with negative numbers, a strength of -40 dbm
is stronger than -60 dbm. In general, we would like to see strengths of -70 dbm or
greater. These numbers may bounce around since they are single samples, but it is
the mean value over time that is important. Re-locating your WIFI router may
improve signal strength. If your layout is too large you may have to use a more
powerful router.

3.15 Adding Legend

A legend is a static element that displays train labels and colors on the layout,
making it easier to identify individual trains. The train colors are shown by the
proximity locators, which are activated as a train passes over them.

An example of a legend is shown below:
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Train Label

UP 3106

UP 3705

Q # Train Color
O

The legend includes all train labels and colors that have been predefined for RFID
tags, as outlined in Section 2.4 Defining RFID Tags. Each label is displayed in a

separate row.

To add a legend, you must be in the Layout Setup mode. From the main menu

select

i Grandpa's Railroad

File View Define Layout Help

Define Layout Size and Type
Shift Layout
Define Custom Turnout

Define RFID Tags

Add Track Segment >
Add Other Component b

Add Border Line

Add Button

Add Proximity Locator

Add Proximity Locator Activated Object >
Add External Input Object »

Add RFID Reader
Add WIFI Module

Add Legend _

Define Layout/Add Other Component/Add Legend

Note: Only one legend is allowed on a layout. Once a legend has been added, the
"Add Legend" menu item will be disabled (grayed out).



Upon selecting this menu item, the following dialog will appear, allowing you to

Locomtive Legend Dialog >

—Legend Position —Legend Sigg ——————————— —Colors
Harizontal in inches Width in inches o |
I a I 0
Border |
Vertical in inches Height in inches
| 0 | 0 —On/Off
Legend currently not displyed
oK Delete | Cancel |

customize the legend properties. You must enter the following parameters.

Legend Position: Specifies the location of the legend's upper-left corner.

Legend Size: Determines the legend's dimensions. The height controls the
size of the train label box and font. All defined labels must fit within this
space, so the height should be sufficient to accommodate them. Once the
height is set, the width should be adjusted to ensure enough space for
displaying the labels. It is best to fine-tune the dimensions through trial and
error.

Colors: Allows customization of the legend's background and border colors.
Pressing either button in this group opens the following dialog.

Color *
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Sat: ﬂ' Green: ﬂ'
Define Custom Colors »» ColoriSolid |- I{In Blue: Iﬂl

0K I Cancel | Add to Custom Colars |




After selecting OK, if all required data has been entered correctly, the legend will
be placed on the layout. Otherwise, a detailed error message will appear,
explaining any issues.

To edit a legend, left-click on the any spot on the legend while in the layout mode,
and this dialog will reappear.
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4 Aids for Building, Troubleshooting, and
Documenting a Control Panel

This chapter introduces software features designed to assist in building a control
panel. These include tools such as axes, grids, connection viewing and printing,
problem detection, and various other useful features for development and
documentation. Some features allow you to customize the appearance of your
control panel to match your preferences. However, not all features are available in
every operational mode.

All these features can be found under the View menu in all modes. The table
below outlines the available features and the corresponding modes in which they
apply.
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Applicable Mode

Feature Layout | Setup | Panel Section
Show Edit Location v NA NA 4.1
Show Axis Scales v NA NA 4.2
Show Grid Lines V NA NA 4.3
Show Layout Boundary v NA NA 4.4
Block Color Assignments (View or Print) v \ \ 4.5
Cab Color Choices V v ' 4.6
Zoom v V V 4.7
Mouse Thumbwheel Zoom v v v 4.8
Dragging a Zoomed Layout to Change Position v v v 4.9
Using the Mouse to Get Precise Coordinates \' NA NA 4.10
Show Control Boxes NA v NA 4,11
Turnout Connections (View or Print) NA v v 4.12
Button Connections (View or Print) NA v \' 4.13
Proximity Locator Connections (View or Print) NA \4 \4 4.14
Proximity Object Connections (View or Print) NA \4 \4 4.15
Proximity DCC Object Connections (View or Print) NA \' \' 4.16
RFID Reader Connections (View or Print) NA \4 \4 4.17
Block Connections (View or Print) NA v v 4.18
Output Pin Usage (View or Print) NA v v 4.19
Input Pin Usage (View or Print) NA v v 4.20
Possible Problem Checking (View or Print) NA \4 \4 4.21
Print All Setup Pages NA \' \' 4.22
Hide Proximity Locators NA NA \' 4.23
Hide Proximity Objects NA NA v 4.24
Hide WIFI Modules When Connected NA NA \' 4.25
Hide Track Block Controls NA NA v 4.26
Hide Border Lines NA NA v 4.27
Show All NA NA v 4.28
Track Color NA NA v 4.29
Show Proximity Locator Connection Network NA v NA 4.30
WIFI Status NA NA V 4.31
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4.1 Show Edit Locations

To activate this feature, navigate to:

View/Show Edit Locations
When enabled, the layout diagram will be annotated as follows:
o Circles at the ends of straight and curved track sections
o Acircle at the center of turnouts displaying the turnout number
« Small circles at the ends of border lines
o The Proximity Locator Number on proximity locators
o The Proximity Object Number on proximity objects

« Buttons and Wi-Fi objects remain unannotated (as they represent the edit
points)

These points indicate edit locations. Clicking on them with the left mouse button
will open the original dialog box used to define the object, allowing you to edit its
parameters.

An example of an annotated layout is shown below:
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If multiple edit locations overlap, their respective dialog boxes will appear
sequentially. You can close any dialogs for objects you do not wish to modify.

Note: This is a very useful way of determining the end points and angles
of track sections and turnouts when building your layout to get track
sections that butt to each other with smooth connections.

For example, to view the endpoints of a turnout, simply open its edit dialog.

Turnout Edit Dialog

Turnout Number 1

Point 1 Position

Horizontal in inches

57.375

Vertical in inches
5.000

Outward Angle Deg
130.000

Turnout Type
Turnout Type
Peco HO Scale Right Hand #8

Block Number 3

Paint 2 Position

Harizontal in inches
70.000

Vertical in inches

5.000

QOutput Angle Deg
0.000

Block Color

Point 3 Position (Curve)
Horizontal in inches

70.006

Vertical in inches
6.007

Curved Rail Angle Deg
6,380

Edit Data

Delete ‘ Cancel

Right Hand Straight Turnout

- Angle

-+ 0 Angle

+Angle
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4.2 Show Axis Scales

To enable axis scales, navigate to:

View/Show Axis Scales

An X and Y scale will appear on the diagram, helping you accurately position
components within your layout. The scales reflect the dimensions of your defined
layout. For example, in a 4x8 foot layout (48x96 inches), the scale numbers
represent inches.

B cusen
Fie View Dein Loyout

10

40

4.3 Show Grid Lines

To display grid lines, navigate to:

View/Show Grid Lines

Equally spaced X and Y grid lines will appear on the diagram, aiding in the precise
placement of layout components. These grid lines are especially useful when used
alongside the Axis Scales.
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Note: In some illustrations, grid lines may appear faint. Zooming in on the image
can improve visibility.

4.4 Show Layout Boundary

To highlight the layout boundary, navigate to:
View/Show Layout Boundary

A light gray frame will appear, marking the defined boundaries of the layout.

B Chtsers Grandpa\OneDrve\Grandpns RairandUsars MarshDibar Feaures Layout Tk

208



4.5 Block Color Assignments (View or Print)
To access this feature, navigate to:

View/View or Print Functions/Block Color Assighments

electing this option opens a window displaying the assigned colors for all blocks
within the layout.

For example, if 12 blocks are defined, their assigned colors will be shown. To
change the color of a block, select any track segment within that block and edit its

color. The new color will automatically apply to all connected segments in that
block.

Block Colors

Block # Block Color

1 ]
2 ]
3

4

5 ]
6

7 ]
8 ]
9 ]
10
11
12 ]
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4.6 Cab Color Choices

To access Cab Color Choices, go to the View menu and select:

View/Cab Color Choices

In a DC system, a cab serves as a throttle control. Grandpa’s Railroad software
supports up to six cabs for DC operation. In contrast, a DCC system has a single
power source for the entire layout, requiring only one cab.

A window will open, displaying the current color assignments for each cab.
Clicking the Cab # button allows you to change the color for a specific cab. These
colors are used in two ways during operation:

» Torepresent a cab power source in Active Block Control
« Asthe track color if Power Source Color is selected

For more details, see Section 4.29: Track Color for Control Panel Additional
Features.

Cab Color Dialog >

I
=

Cab g

44333

QK. Cancel
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4.7 Zoom

To zoom in on the control panel, go to the View menu and select:

View/Zoom

B C\Users\Grandpa\OneDrive\Grandpas Railroad\Users Manual\Other Features
File View Define Layout Help

Show Edit Locations

Show Axis Scales

Show Grid Lines

Show Module or Layout Boundary

View or Print Functions >

Zoom ¥ 1.0
1.25
1.5
1.75
2.00
2.50
3.00
3.50
4.00

A menu will appear, allowing you to magnify the Control Panel Display from 1x to
4x. At 1x magnification, the entire control panel fits within the display. At higher
magnifications, the view expands relative to the base window size, making the full
panel no longer visible in a single view. In such cases, horizontal (bottom) and
vertical (right) scrollbars will appear, allowing you to navigate the display.

For more details on repositioning the zoomed view, see Section 4.9 Dragging a
Zoomed Layout to Change Position.

4.8 Mouse Thumbwheel Zoom

Another way to zoom is by using the mouse wheel. The zoom effect centers
around the mouse cursor when scrolling begins:

« Rolling the wheel upward increases magnification.
e Rolling the wheel downward decreases magnification.

The zoom range is from 1x to 4x. This method is particularly useful for large
layouts, allowing you to focus on specific areas for easier interaction, such as
clicking on turnouts.
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4.9 Dragging a Zoomed Layout to Change Position

To reposition a zoomed display, place the mouse cursor over the display, hold
down the right mouse button, and drag the view left, right, up, or down.

4.10 Using the Mouse to Get Precise Coordinates
If you need to place a component at an exact location, an easy way to determine
its coordinates (in the layout mode only) is as follows:

1. Move the cursor to the desired point.
2. Hold down the right mouse button.

3. The x and y coordinates (in inches) will appear in the lower-left corner of
the window.

This method also works when the display is zoomed in.

¥ =225units y=31.0units

4.11 Show Control Boxes

To display control boxes, navigate to the View menu and select:

View/Show Control Boxes
The layout diagram will be annotated as follows:

« Circles at the center of straight and curved track sections if no block control
exists.

« Acircle at the center of turnouts, displaying the turnout number.
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o The Proximity Locator Number on proximity locators.
« The Proximity Object Number on proximity objects.

o Buttons and Wi-Fi objects remain unannotated, as they serve as control
points.

These annotations indicate the locations of Control Boxes. By clicking the left
mouse button on any of these points, a dialog box will appear, allowing you to
define or edit the control parameters for the object.

For more details on these dialogs, refer to the sections on adding specific
components to the layout in Chapter 3.

An example of an annotated layout is shown below:

Crossing Bell

4.12 Turnout Connections (View or Print)
From the main menu select:

View/View or Print Functions/Turnout Connections

Selecting the "View" option opens a window that displays the parameters for all
turnout connections. This is useful not only for documenting your configuration
but also for verifying that all parameters are properly defined. A sample window is
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shown below:

i

Turnout Connections

Turmnout# Block# WIFIModule#  Output Pin# Response Reversed Paired Paired Turnout #
1 3 2 1 NO YES 2
2 4 2 2 NO YES 1
3 l 8 l 5 6 YES YES 4
4 7 5 5 YES YES 3

Selecting the "Print" option generates a similar table.

4.13 Button Connections (View or Print)
From the main menu select:

View/View or Print Functions/Button Connections

Selecting the "View" option opens a window that displays the parameters for all
button connections. This is helpful for documenting your configuration and
ensuring all parameters are defined correctly. A sample window is shown below:

Button Connections

Button Title 1

Button Title 2

Button Title 3

Calor On  Color Off # of Pins

WIFI Module Pin #s

Inverted  Shared Use

Qutside Main
Inside Main
Cab1 Off Cab2
Crossing Bell

On or Off

 —
—

 E—
—

0
0
0
1

(5.8)

NO
NO
NO
NO

OR
OR
OR
AND

Selecting the "Print" option generates a similar table.

In this example, buttons without Wi-Fi connections are used as labels rather than

functioning buttons. For a definition of the parameters, refer to Section 3.5
Adding a Button.
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4.14 Proximity Locator Connections (View or Print)
From the main menu select:

View/View or Print Functions/Proximity Locator Connections

Selecting the "View" option opens a window displaying the parameters for all
proximity locator connections. This is useful for documenting your configuration
and verifying that all parameters are defined. A sample window follows:

=3 ==
Proximity Locator Connections
Proximity Locator # Type  On Level Filter Type WIFI Module,Pin#  Neighbor# Tumout# Neighbor#  Tumout#

1 Reflective 6 Medium Delay 1.13 2 60
2 Reflective 6 Medium Delay 1,15 3 1
3 Reflective 6 Medium Delay 18 4 2
4 Reflective 6 Medium Delay 1.7 5 3
5 Reflective 6 Medium Delay 1.1 4 6
6 Reflective 6 Medium Delay 1.3 5 7
7 Reflective 10 Small Delay 2,16 8 6
8 Reflective 10 Small Delay 214 9 T
9 Reflective 10 Small Delay 2.1 10 8
10 Reflective 10 Small Delay 2.7 " 9
1" Reflective 10 Small Delay 23 12 10
12 Reflective 10 Small Delay 3,16 11 13
13 Reflective 10 Small Delay 38 12 14
14 Reflective 10 Small Delay 3.2 13 15
15 Reflective 10 Small Delay 416 14 16
16 Reflective 10 Small Delay 49 15 17
17 Reflective 10 Small Delay 48 16 18
18 Reflective 10 Small Delay 4.1 17 19
19 Reflective 10 Small Delay 513 18 20
20 Reflective 10 Small Delay 515 19 21
21 Reflective 10 Small Delay 59 20 22122 1
22 Reflective 10 Small Delay 57 21 23
23 Reflective 10 Small Delay 51 22 24
24 Reflective 10 Small Delay 53 23 25
25 Reflective 10 Medium Delay 6,13 24 26
26 Reflective 10 Medium Delay 6,15 25 27
27 Reflective 10 Medium Delay 6.9 26 28
28 Reflective 10 Medium Delay 6.7 27 29
29 Reflective 10 Medium Delay 6.1 28 30
an Reflartive 10N Medinm Nelawv A3 20 21

Selecting the "Print" option generates a similar table. For a definition of the
parameters, refer to "Adding a Proximity Locator.".

4.15 Proximity Object Connections (View or Print)
From the main menu select:

View/View or Print Functions/Proximity Object Connections
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Selecting the "View" option opens a window displaying the parameters for all
proximity object connections. This is useful for documenting your configuration
and verifying that all parameters are defined. A sample window follows:

Proximity Objects
‘Object,Element # Object Type Directional Color On Color Off # of Proximity Locators Proximity Locator #s # of Output Pins ~ Output Module, Pin #s
51,1 On ifany of my Proximity Locators (PLs) On ~ NO IS EE— 8 10612345621 1 (6:6)
512 Onif any of my PLs Onbut no other element On -~ NO I N 2 2223 1 (6.5)
513 On if no other Element On NO I E— 0 1 (6.4)
521 On if any of my Proximity Locators (PLs) On NO N 8 11611121314 1516 31 1 (6.3)
522 Onifany of my PLs Onbut no other element On~ NO I I 2 3233 1 6.2)
523 On if no other Element On NO I 0 1 6,1)
531 On if any of my Proximity Locators (PLs) On  YES I 10 11196959493 929176 75 112 2 (4.5) (4.6)
541 On if any of my Proximity Locators (PLs) On  YES I 8 102 1018685929176 75 2 (4,5) (4.6)
551 On if any of my Proximity Locators (PLs) On  YES I 10 53545556717273747576 2 (4.,5) (4.6)
56,1 On if any of my Proximity Locators (PLs) On ~ YES I 10 102101 86 8584 83 82 81 66 65 2 (45) (4.6)
571 On if any of my Proximity Locators (PLs) On  YES — 10 43 44 45 46 61 62 63 64 65 66 2 (4,5) (4,6)
1 Train Colision YES I 9 84 83 66 65 64 6362 61 46
2 Train Colision YES I 9 949376757473727156
3 Train Golision YES L 14 6465818283 848586 101 102 103 104 105 106

Selecting the "Print" option generates a similar table.
For a definition of the parameters, refer to Section 3.7 "Adding Gate, Signal, or
Animation" and Section 3.8 "Adding Collision Avoidance."

4.16 Proximity DCC Object Connections (View or Print)

From the main menu select:

View/View or Print Functions/Proximity DCC Object Connections

Selecting the "View" option opens a window displaying the parameters for all
proximity DCC object connections. This is useful for documenting your
configuration and verifying that all parameters are defined. A sample window

follows:
Proximity DCC Objects
Object# Color On  Color Off Directional Proximity Locator #s DCC Event Sequence
1 I YES 23 DT =0000 Same Direction Speed=25%

DT=0000 Horn Tum ON
DT=1.000 Horn Turn OFF

Selecting the "Print" option generates a similar table.
For a definition of the parameters, refer to Section 3.9 Adding DCC Event or

Sequence.
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4.17 RFID Reader Connections (View or Print)

From the main menu select:

View/View or Print Functions/RFID Reader Connections

Selecting the "View" option opens a window displaying the parameters for all RFID
Reader connections. This is useful for documenting your configuration and
verifying that all parameters are defined. A sample window follows:

] = [ ][ =
|
RFID Readers
RFID Reader#  RFID Module#  Connection#  Nearest Proximity Locators
1 3 1 120
2 3 2 910
3 4 1 119120
4 4 2 110111

Selecting the "Print" option generates a similar table.
For a definition of the parameters, refer to Section 3.13 Adding a RFID Reader.

4.18 Block Connections (View or Print)
From the main menu select:

View/View or Print Functions/Block Connections

Selecting the "View" option opens a window displaying the parameters for all
block connections. This is useful for documenting your configuration and verifying
that all parameters are defined. A sample window follows:
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Block Connections

Block Connection Type Output Module Pin #
I | . Another Block 1.3
I Anaother Block 1.4

3 Anaother Block 1.1
4 Anaother Block 1.2
| — -, Anather Block 43
6 Anather Block 44
I 7 Another Block 41
N . Another Block 4.2
o Cab 4.9
o Cab 410
10 Cab 411
10 Cab 412

Selecting the "Print" option generates a similar table.
For a definition of the parameters, refer to Section 3.1 Adding a Straight Track
Section.

4.19 Output Pin Usage (View or Print)

From the main menu select:

View/View or Print Functions/Output Pin Usage

Selecting the "View" option opens a window displaying the usage of all connected
output pins. This is helpful for documenting your configuration and verifying that
all parameters are defined and the connections are correct. A sample window
follows:
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Output Pin Usage

WIFI Module # Pin# Connection Type Object or Block # Shared Use
1 1 Track Block 3 NA
1 2 Track Block 4 NA
1 3 Track Block 1 NA
1 4 Track Block 2 NA
2 1 Turnout 1 NA
2 2 Turnout 2 NA
4 1 Track Block 7 NA
4 2 Track Block 8 NA
4 3 Track Block 5 NA
4 4 Track Block 6 NA
4 9 Track Block 9 NA
4 10 Track Block 9 NA
4 11 Track Block 10 NA
4 12 Track Block 10 NA
5 5 Turnout 4 NA
5 6 Turnout 3 NA
5 8 Button 4 AND

Selecting the "Print" option generates a similar table.

4.20 Input Pin Usage (View or Print)

From the main menu select:

View/View or Print Functions/Input Pin Usage

Selecting the "View" option opens a window displaying the usage of all connected
input pins. This is helpful for documenting your configuration and verifying that all
parameters are defined and the connections are correct. A sample window
follows:

Input Pin Usage

WIFI Module # Pin# Connection Type Object or Block # Shared Use

2 1 Turnout 1 NA
2 2 Turnout 2 NA
5 5 Turnout 4 NA
5 6 Turnout 3 MNA
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Selecting the "Print" option generates a similar table.

4.21 Possible Problem Checking (View or Print)

From the main menu select:

View/View or Print Functions/Possible Problem Checking

Selecting the "View" option opens a window displaying potential issues with the
control panel setup. These are divided into errors and warnings. Errors must be
resolved for proper operation, as unresolved errors could lead to erratic behavior.
Warnings are less critical and may result from testing before the layout is fully
complete. A sample window showing errors intentionally created follows:

[+ S @ [=

Layout Setup Problems

Problem Severity
Turnout#2 WIFI Module# 5 Pin#8  used by Button labeled  Crassing Bell Error
Tumout# 3 WIFI Module# 5 Pin# 5 used by Tumout # 4 Error
Proximity Locator # 151 has not had it's WIFI module and pin defined. Warning

Selecting the "Print" option generates a similar table.

4.22 Print All Setup Pages

From the main menu select:

View/View or Print Functions/Print All Setup Pages

Selecting this option prints a document containing all the information from
sections 4.12 — 4.21, offering a detailed description of the control panel setup.

4.23 Hide Proximity Locators

From the main menu select:

View/Hide Proximity Locators
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File View Help

View or Print Functions »
Hide Proximity Locators b Always
Hide Proximity Objects When Off

Hide WIFI Madules When Connected
Hide Track Block Controls
Hide Border Lines

Show All

WIFI Status

Track Color >
Zoom >

This option allows you to customize your control panel during operation. Selecting
this item presents options to hide proximity locators either always or only when
they are off. If you previously selected one of these options, it will be checked
when you return to the menu. Simply click again to deactivate the option.

4.24 Hide Proximity Objects

From the main menu select:

View/Hide Proximity Objects

This option allows you to customize your control panel during operation. Selecting
this item hides all proximity objects that are off, while active objects remain
visible. Activating this option can simplify your display. If you previously selected
this option, it will be checked when you return to the menu. Click again to
deactivate it.

4.25 Hide WIFI Modules When Connected

From the main menu select:

View/ Hide WIFI Modules When Connected

This option allows you to customize your control panel during operation. Selecting
this item hides all WIFI modules when they are properly connected. If a module
loses connection to the router, it will reappear. Activating this option can simplify
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your display. If you previously selected it, it will be checked when you return to
the menu. Click again to deactivate the option.

4.26 Hide Track Block Controls

From the main menu select:

View/ Hide Track Block Controls

his option allows you to customize your control panel during operation. When
Active Block Controls are added to a track segment, you can choose to make them
hideable (see Section 3.1 "Adding Straight Track"). Selecting this item hides all
Active Block Controls marked as hideable. If you previously selected this option, it
will be checked when you return to the menu. Click again to deactivate the option.

4.27 Hide Border Lines

From the main menu select:

View/ Hide Boundaries

This option allows you to customize your control panel during operation. When
Border Lines are added to the layout, you can choose to make them hideable (see
Section 3.4 Adding Border Lines"). Selecting this item hides all Border Lines
marked as hideable. If you previously selected this option, it will be checked when
you return to the menu. Click again to deactivate the option.

4.28 Show All

From the main menu select:

View/ Show All

Selecting this option reveals all control panel elements that were previously
hidden.

4.29 Track Color

From the main menu select:
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View/ Track Color

File View Help
VYiew or Print Functions »
Hide Proximity Locators »
Hide Proximity Objects
Hide WIFI Modules When Connected
Hide Track Block Controls
Hide Border Lines

Show All

WIFI Status

Track Color > Block Color
COne Col

Zoom . ne Color

Power Source Colar

This option allows you to customize how the track is displayed on the layout. The
first option, Block Color, shows the track in the color previously assigned to its
block when the layout was defined. The second option, One Color, allows you to
assign a single color to all track elements. The final option, Power Source Color, is
useful for DC operation. It colors each track block according to the cab (throttle) it
is connected to. If the block is off, the color will be black.

4.30 Show Proximity Locator Connection Network

Sometimes, a graphical representation is the best way to check for errors. While
the Proximity Locations Table (see Section 4.14) can help review proximity
neighbors, it doesn't visually show the connections or data flow. To see these
connections physically, from the main menu, select:

View/Show Proximity Locator Connection Network

An image of the connections will appear. An example is provided below:

223



Crossing Bell

In this example, train data flows in the direction of the arrows from one locator to
the next. (Proximity locator numbers can be displayed on the connectivity diagram
by using "Show Control Boxes.") A closer look at the outer track on the far left
reveals that there is no arrow for data flowing from locator 3 to locator 2. This is
an error that may not have been detected by reviewing the table. You can edit the
data in the diagram by clicking the proximity locator with the left mouse button.
The Proximity Locator Dialog will open, allowing you to edit the neighbors.

*

Proximity Locator Contrel Dialog

Proximity Locator Mumber # 3

Proximity Pin Number Filter Type Neighboring Connections
WIFI Module # | 1 " None Proximity Locator
1 .
Pin # 9 " Shortest Delay
1 " Mot Used {+ Straight ¥ (turnout)
H " Short Delay
(% Medium Delay Proximity Locator # |4
Trigger Level
lﬁi " Normal Delay
" Long Delay
" Extra Long Delay
Proximity Locator
" Mot Used {+ Straight ¥ (turnout)
oK Cancel ‘ Proximity Locator # | 2
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4.31 WIFI Status

From the main menu, select:

View/WIFI Status

Selecting this item opens a window displaying the current power settings of each
WIFI module. This is useful for locating your router relative to the modules. It also
provides the firmware version number for each module and other related data.

i = [= | =
|
WIFI Status
WIFI Module # Module Ver Power UF LD
1 2.1 -44 99 0

The most important number in this window is the Power value, measured in dbm
(decibel milliwatts). A smaller number indicates weaker signal strength. To clarify,
-40 dbm is a stronger signal than -60 dbm. Generally, a signal strength of -70 dbm
or greater is desirable. While signal strengths can fluctuate due to single samples,
the mean value over time is most important. Relocating your WIFI router may

improve signal strength, and if your layout is large, you may need a more powerful
router.
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5 Special Topics for Grandpa’s Railroad
Construction

This chapter covers special topics and insights we've gained, along with specific
details on how to connect certain features to your layout. While we don’t claim
these methods are the only possible solutions, they represent the way we
approach things. We encourage our users to share their suggestions so we can
learn and pass along their insights to the community.

5.1 Selecting the Right Wire Gauge

Selecting the right wire gauge for your model railroad and accessories can lead to
hours of uninterrupted operation. Selecting the wrong gauge could lead to
unnecessary expense, poor operation, or even wires overheating. For your
understanding we are going to go into further detail as to why this occurs and how
to choose the proper wire gauge. You do not have to understand everything we
will present because we also present an easy way to calculate your wire size with
some examples.

5.1.1 Background and Theory

In Episode 2 of our “Electricity 99” video tutorial series, Grandpa shows an
analogy between current flow and water flow. Let’s use that analogy to
demonstrate our point. If firemen arrived at a house fire with only garden hoses,
I’m sure the house would burn down before they could put the fire out. That is
because the garden hose can’t deliver the amount of water needed. Likewise, I'm
sure you could water your garden with a fire hose but since you don’t need the
volume of water it could deliver you would just be wasting money on purchasing
such a hose. The same holds true for electrical wire. Why purchase an oversized
wire if a smaller one would suffice. It would be a waste of money and space under
your layout. The converse of this is even more important. If you use too small a
wire for an application, two very important things happen, voltage drop, and the
wire will heat. In extreme cases the heat could cause the insulation to melt or
even catch fire. Let’s look a little closer as to why these two things happen.
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We learned from “Electricity 99”, that electricity is electrons in motion and current
is @ measure of the movement of electrons in a wire over time. Wire has a
resistance based on its material and diameter. This resistance results in a voltage
drop in the wire and causes heating of the wire. If we have too large of a voltage
drop your model train may run at different speeds depending on where you are
on your layout. The voltage drop may also cause accessories to function slowly or
improperly.

For model railroading there are only three types of wire we will consider:

1. Copper
2. Aluminum
3. Copper clad aluminum

The last type, copper clad aluminum, for simplicity we will consider as having the
same conductivity as the aluminum wire. This wire is basically aluminum with a
copper coating to aid in making connections.

A materials resistivity (p) is a measure of that materials ability to conduct
electricity and is given by its resistance (R) times it’s cross-sectional area (A)
divided by a unit length (L).

The resistivity of copper is 1.72x10-8 Qm or 5.6429x10-8 Qft.
For aluminum wire the resistivity is 2.82e-8 Qm or 9.2519x10-8 Qft.

Rearranging the above equation, we can solve for the resistance (R) of a single
strand of wire.

_pL
A

The area of a round wireis A = mr? where r the radius is the wire diameter
divided by 2.

R

For a particular wire gauge n AWG, the diameter can be calculated as

d, = 0.005 inches x 92(36-)/39
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For example, if we consider a single strand of gauge 22 AWG wire, the diameter in
inches is

d,; = 0.005 inches x 92635-22/39 = 0,005 inches x 924/3° = 0.0253 inches

Therefore, the area A is
A =1 (0.0253/2)? = 0.0005027 in* = 0.0005027 in?
Converting to ft? by dividing by 144 in?/ ft?
A =3.4911x10° ft?
The resistance for a 10 ft length of 22 AWG copper wire would be
R =5.6429x10-8 Qft X 10 ft / 3.4911x10° ft*=0.1616 Q

Episode 3 of our “Electricity 99” video tutorial series, presented Ohm’s Law which
shows the relationship between current voltage and resistance in a circuit.

V(Volts) - I(Amps) * R(Ohms)
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Now consider a simple circuit where the wires in the circuit have resistance as
follows:

Vsupply - VDrop

i |I
VSupplv

Assume the two wires are of equal length with a resistance of Rwire. Since there is
only one path in this circuit, the current (I) flows through the entire circuit.
Applying Ohms Law

Vsupply = Vorop = | X Rioad
Rioad = VSuppIy - VDrop/ I
VSuppIy =lx RWire + VSuppIy = VDrop +1x RWire;
VDrop =2xl1x RWire;

Voltage Drop % = 2 x | X Rwire; / Vsuppiy X 100
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Using the 10 ft 22 AWG wire we calculated above, for a 12 V supply and a 0.25
amp load current, the voltage drop is

Vbrop =2 x 0.25 amp x 0.1616 Q = 0.0808 volts
Voltage Drop % = 0.0808 volts / 12 volts x 100 = 0.6733%

The above discussion is the way the voltage loss is calculated. Doing this for every
wire would be more complex than necessary. The following section shows a much
easier way.

5.1.2 Solid vs Stranded Wire

Stranded wire is more flexible than solid wire and if this is a consideration it
should be used. However, stranded wire of the same gauge (AWG) has a higher DC
resistance than solid wire since the wire has air gaps between strands. This can be
20% to 50%. This should be taken into consideration if you choose to use stranded
wire in the following discussion of wire size. On Grandpa’s Railroad we use solid
wire in all cases except if we use RJ11 or RJ45 connectors or for very low
amperage application such as IR sensors.

5.1.3 Calculating Wire Size with Examples (The Easy Way)
There are many Voltage Drop Calculators online. One that we use is:

https://www.rapidtables.com/calc/wire/voltage-drop-calculator.html

For the low voltages used in model trains, a voltage drop of 2% to 3% is fine.
These low levels cause no temperature problems and even on track power wires
show no slowing of trains. Likewise, accessories do not seem to be affected. These
voltage drop levels also do not seem to place an undue burden on wire size. On
Grandpa’s Railroad we use telephone wire for many applications. This type of wire
is cheap, easy to get, and easy to work with.

5.1.3.1 Calculating Wire Size for Track Power There are many opinions on power
requirements for N or HO scale engines since these vary based on manufacture
and age of equipment. To calculate wire size, we don’t need to know specific
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values only a general idea of the requirements. For planning purposes, | use 12V
0.25 amp for N scale and 14V 0.5 amp for HO scale.

Assume we have a block in our layout that we wish to wire that will runup to 4
HO locomotives. This would need wiring to support 14V at 2 amps. Also assume
the supply line (main bus) will need to be 20 ft long to travel from the transformer
to the block.

To calculate wire size, we must first choose a preferred wire type. | find that 18-
and 14-gauge copper clad aluminum wire is cheap and comes in many colors since
it is commonly used in cars. It has many connector types that can be used with it
and most of these can be used on both gauges requiring the need for stocking
fewer types. (Connectors will be covered in Section 5.3)

Using the calculator given above and these values we see that an 18-gauge
produces a voltage drop of 5.97% which is well above our desired 3%.

Wire type: Aluminum v

Resistivity: 2.82e-8 Q-m

Wire diameter size: 18 AWG v
Wire/cable length (one way): |20 feet ~
Current type: DC v

Voltage in volts: 14 A%

Current in amps: 2 A

Calculate | Reset

Voltage drop in volts: 0.835467 A%
Percentage of voltage drop: 5.96762 %
Wire resistance: 0417734 Q
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Using a 14-gauge wire the results produce a 2.36% drop which is not only

Wire type: ‘ Aluminum e |

Resistivity: 2.82e-8 Q'm

Wire diameter size: 14 ‘ AWG v ‘
Wire/cable length (one way): |20 ‘ feet v ‘
Current type: ‘ DC v |

Voltage in volts: 14 v

Current in amps: 2 A

‘ Calculate | ‘ Reset ‘

Voltage drop in volts: 0.330447 A"
Percentage of voltage drop:  2.36033 %
Wire resistance: 0.165223 Q

acceptable but also provides some room for loss from feeder wires to the track.
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Let’s assume we use a 1 ft 20-gauge feeder wire from the main bus 14-gauge wire
to the track. The voltage drop is 0.47% which when added to the 2.36% main bus

Wire type: Aluminum v

Resistivity: 2.82e-8 Q-m

Wire diameter size: 20 AWG v
Wire/cable length (one way): |1 feet v
Current type: DC v

Voltage in volts: 14 A%

Current in amps: 2 A

Calculate || Reset

Voltage drop in volts: 0.0664223 A%
Percentage of voltage drop:  ().474445 %
Wire resistance: 0.0332111 Q

the loss is still below 3%. Although model train track is conductive, it is still a good
idea to connect from the main bus wire to the track in multiple places. Let’s
assume 3 for this example. From the above figure, we see that one wire has a
resistance of about 0.033 Q. We are now effectively connecting three wires with a
0.033 Q resistance in parallel. In Episode 5 of our “Electricity 99” video tutorial
series, we saw that resisters in parallel have an equivalent resistance of

1 1 1 1

RT R4 R, R3
Therefore, the three wires are equivalent to

11 1,1
Ry 0.033  0.033 0.033

or Rr=0.011 Q.
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Using the calculator to determine a near equivalent wire gauge, we find that a

Wire type: Aluminum v

Resistivity: 2 .82e-8 Q-m

Wire diameter size: 15 AWG
Wire/cable length (one way): | 1 feet v
Current type: DC v

Voltage in volts: 14 \%

Current in amps: 2 A

Calculate | Reset

Voltage drop in volts: 0.0208343 \%
Percentage of voltage drop:  (0.148816 %
Wire resistance: 0.0104171 Q

gauge of 15 provides a nearly equivalent resistance. The percentage of voltage
drop is only 0.149%. Thus, multiple connections will not only cause less
dependency on the track as a conductor, but also reduces the voltage drop for the
equivalent feeder wire.

For this example, we can use a use a 20 ft 14-gauge aluminum main supply wire
and three 1 ft aluminum feeder wires to the track and achieve a 2.51% voltage
drop.

5.1.3.2 Calculating Wire Size for Accessories On Grandpa’s Railroad we chose to
use 12 V as our main accessory power supply. We convert this to 5 V when
necessary to power WIFI modules, servos, etc. Since most accessories are near
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their controller (WIFI card) very short wire lengths can be used. This results in
small gauge wires being possible with low voltage drops. Where possible we use
telephone wire in these situations because it is cheap with various connector
options. Typically, these wires are copper which has lower resistance.

A Tortoise Switch Machine is said to use only 16 milliamps. If we drive it at 12
volts, (using the above voltage drop calculator) we see that a 26-gauge copper
wire has a voltage drop of only 0.05% over 5 ft and 0.22% over 20 ft. Therefore

Wire type: Copper v

Resistivity: 1.72e-8 Q-'m

Wire diameter size: 26 AWG ~
Wire/cable length (one way). |5 feet v
Current type: DC v

Voltage in volts: 12 \Y%

Current in amps: 016 A

Calculate || Reset

Voltage drop in volts: 0.006514/1 \%
Percentage of voltage drop:  ().0542893 %
Wire resistance: 0.40717 Q

26-gauge telephone wire is totally acceptable for this application.

LED lights typically draw 20 ma. If we use a 12-volt supply (with resistor) and 25
LEDs connected for a small scene, this would be 0.4 amps. Using the calculator
this is @ 2.71% drop over 10 ft. (Note: In the case of LEDs lowering the voltage
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drop would be of no significance. We showed in Episode 6 of our “Electricity 99”
video tutorial series that LED lights required a large voltage drop before becoming
noticeably dimmer. Again, it is a good place to use 26-gauge phone wire.

Small servo motors can draw 0.25 amps during operation typically at 5 volts. If we
apply these parameters to the calculator, we see a 2.04% drop at 5 ft. Since
accessories are typically close to their controller (WIFI card) 26-gauge phone wire
is appropriate.

Note: In some cases (where WIFI has not been used to replace long wire runs),
larger gauge wire may need to be used for accessories.

5.2 Making your own Cables

Often, when working on a model railroad, you may want to use a cable containing
multiple wires to keep the wiring neat and organized. For instance, on Grandpa’s
Railroad traveling layout, we’ve wired it to run on two DC throttles for the two
parallel main lines. This setup requires two sets of wires to supply track power to
the mainlines. While running a four-wire cable seems like a good idea, it has
several disadvantages. Four-wire, 14-gauge cables can be expensive, and it’s
difficult to access and separate the wires when you need to add feeder wires for
powering the track. It’s much easier and more cost-effective to make your own
cable (wire bundle) using heat shrink tubing.

Individual wire strands come in a variety of colors, which makes identifying each
wire in the bundle simple. (It’s a good practice to reserve specific colors for certain
functions on your layout. For example, we use red for our positive 12-volt DC
accessory supply wire and black for ground.)

The following table shows the heat shrink tubing we use:

Wire Type - Heat Shrink Tube
Gauge Number of wires
14 4 1/4 inch (6mm) 2:1 shrink ratio
14 2 3/16 inch (5mm) 2:1 shrink ratio
18 4 3/16 inch (5mm) 2:1 shrink ratio
18 2 1/8 inch (3mm) 2:1 shrink ratio
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Before shrinking, the wire is held in place, and it’s easy to slide the tubing on.
After shrinking, the wire is tightly secured together. We typically use 1-inch pieces
of tubing spaced 6 to 8 inches apart, leaving enough room for adding connectors
between the tubing. Below are images of a cable before and after shrinking.

on Grandpa’s Railroad YouTube Channel.
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5.3 Wire Connectors Coming Soon

5.4 Adding Sound Coming Soon

238



6 Glossary

Connectivity Network A group of proximity locators each knowing its nearest
neighbors so that information can be passed among them.
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